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Preface

Thank you for purchasing Multifunctional Digital Systems. This manual explains how to use the e-Filing. Read this manual
before using your Multifunctional Digital Systems. Keep this manual within easy reach, and use it to configure an
environment that makes the best use of the functions.

This manual supports the following models.

MB760dnfax, MB770dn, MB770dnfax, MB770dfnfax, ES7170dn MFP, ES7170dfn MFP, MB760, MB770, MB770f,
MPS5502mb, MPS5502mbf

Bl How to read this manual

0 Symbols in this manual

In this manual, some important items are descried with the symbols shown below. Be sure to read these items before
using this equipment.

A WARNING Indicates a potentially hazardous situation which, if not avoided, could result in death, serious
injury, or serious damage, or fire in the equipment or surrounding objects.

A CAUT'ON Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate
injury, partial damage to the equipment or surrounding objects, or loss of data.

Indicates information to which you should pay attention when operating the equipment.

Other than the above, this manual also describes information that may be useful for the operation of this equipment with
the following signs:

Tip Describes handy information that is useful to know when operating the equipment.
|RA Pages describing items related to what you are currently doing. See these pages as required.

O Screens and Operation Procedures

* In this manual, the screens and the operation procedures in Windows are described for Windows 7.
The details on the screens may differ depending on how the equipment is used, such as the status of the installed
options, the OS version and the applications.

* If you use Windows Server 2008 R2, refer to the operation procedure for Windows 7, though the screens or the menu
names, etc. may differ.

* The illustration screens used in this manual are for paper in the A/B format. If you use paper in the LT format, the
display or the order of buttons in the illustrations may differ from that of your equipment.
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O Trademarks

* The official name of Windows Vista is Microsoft Windows Vista Operating System.

* The official name of Windows 7 is Microsoft Windows 7 Operating System.

* The official name of Windows 8 is Microsoft Windows 8 Operating System.

* The official name of Windows Server 2003 is Microsoft Windows Server 2003 Operating System.

* The official name of Windows Server 2008 is Microsoft Windows Server 2008 Operating System.

* The official name of Windows Server 2012 is Microsoft Windows Server 2012 Operating System.

* Microsoft, Windows, and the brand names and product names of other Microsoft products are trademarks of Microsoft
Corporation in the US and other countries.

* Apple, AppleTalk, Macintosh, Mac, Mac OS, Safari, and TrueType are trademarks of Apple Inc. in the US and other
countries.

* Adobe, Acrobat, Reader, and PostScript are either registered trademarks or trademarks of Adobe Systems
Incorporated in the United States and/or other countries.

* Mozilla, Firefox and Firefox logo are trademarks or registered trademarks of Mozilla Foundation in the U.S. and other
countries.

* IBM, AT and AlX are trademarks of International Business Machines Corporation.

¢ NOVELL, NetWare, and NDS are trademarks of Novell, Inc.

* TopAccess is a trademark of Toshiba Tec Corporation.

* Other company and product names given in this manual or displayed in this software may be the trademarks of their
respective companies.
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e-Filing OVERVIEW

This chapter describes overview of the e-Filing features and functions.
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e-Filing Features

The e-Filing is installed in a hard disk of this equipment. It allows you to store documents and to print/edit/manage the
stored documents.

This section describes the system of e-Filing for storing documents.

Control Panel Client Computer

Documents stored by the
printing operation (printer
driver)

Documents stored by the
copying/scanning operation

N\,

Documents stored by

receiving Internet Fax / FAX

7~

EaPublicBox
[:__JFoIder % % E:
Toplog o e 48
EEBE |FEE
5 5 U5 All users
UserBox
[T Folder = = =
foder | T F = 0 l
EEB |BFE
7 == L Specified users
(or administrators)

Public Box

The public box is an e-Filing created by default. All users can access it, so it is suitable to store shared documents which
any user may need to work with. Since the public box is a built-in system box, you cannot change the name of the box /
create a new box / delete the box.

User Box

The user box is an e-Filing that each user can create. The user box can be protected by a password to limit access. It is
suitable for specific users or an administrator to store confidential documents. You can also create a user box without
setting a password. In this case, all users can access the user box as well as the public box.

(Up to 200 user boxes can be created.)

Folders

You can create folders in each box. However, you can create only one level of folders within each box. You cannot create
subfolders within folders.
(Up to 100 folders can be created in a box.)

6 e-Filing Features



Documents

Documents can be stored in a box or folder in the following methods.

(Up to 400 documents can be stored in a box or folder. / Up to 200 pages can be contained in a document.)

* Copying documents and storing to e-Filing

¢ Scanning documents and storing to e-Filing

* Printing documents in a client computer and storing to e-Filing

* Received Internet Faxes / received faxes are forwarded to store to e-Filing using forward functions.

* Received Internet Faxes / received faxes are forwarded to store to e-Filing using forward mailbox functions.

» Storing the received faxes is available only when FAX Unit is installed.
* Depending on the amount of data stored in e-Filing, it may take some time from when the equipment is turned on to
e-Filing becoming ready for use.

Tips

* For details of the forward functions, refer to the TopAccess Guide.
* For details of the forward mailbox functions, refer to the User’s Manual Advanced Guide and TopAccess Guide.
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e-Filing Functions

H Functions operated with this equipment

Below is a list of e-Filing functions that you can operate with this equipment. For details of the operation, see the
references described below.

QO Printing documents

The following functions allow you to print documents stored in the e-Filing.
* To print an entire document

P.12 “Printing an entire document”
» To print specified pages of the document for confirmation

P.15 “Test print”

0 Storing documents

The following functions allow you to store documents in the e-Filing.
* To copy and store documents
P.17 “Copying and storing to e-Filing”
* To scan and store documents
P.22 “Scanning to e-Filing”

U Deleting documents

To delete documents in the e-Filing
P.24 “Deleting Documents”

0 Managing user boxes/folders

The following functions allow you to manage user boxes and folders in the e-Filing. You cannot create and edit folders in
boxes using the control panel. Folders can be created using a client computer.
* To create new user boxes
P.26 “Creating user boxes”
* To change the registered user box name and password
P.28 “Editing user boxes”
* To delete user boxes and folders
P.30 “Deleting user boxes/folders”
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B Functions operated with a client computer

Below is a list of e-Filing functions that you can operate with a client computer (e-Filing web utility). For details of the
operation, see the references described below.

e-Filing web utility supports only Windows. Mac OS and other computers are not supported.

0 Managing user boxes/folders

The following functions allow you to manage user boxes and folders in the e-Filing.

To create new user boxes and folders

P.44 “Creating user boxes and folders”

To delete user boxes and folders

P.47 “Deleting user boxes and folders”

To edit (renaming and changing Properties) user boxes and folders
P.50 “Renaming user boxes and folders”

P.54 “Modifying and displaying user box and folder properties”

0 Managing documents

The following functions allow you to manage documents stored in the e-Filing.

To display document image files in thumbnail view and list view
P.60 “Displaying documents”

To rename documents

P.61 “Renaming documents”

To delete documents

P.63 “Deleting documents”

To print documents (entire document/test print)
P.64 “Printing an entire document”

P.68 “Selecting test print”

To store documents by printing operation

P.70 “Storing documents”

To archive documents

P.73 “Archiving documents”

To send documents as Emails

P.78 “Sending Email”

Q0 Editing documents

The following functions allow you to edit documents stored in the e-Filing.

To display document and page Properties

P.89 “Displaying document and page properties”

To copy/cut pages from a document and paste them into another one
P.90 “Copying pages from one document to another”

To copy/cut pages from a document and save them as a new document
P.95 “Copying pages from a document to a box or folder”

To delete pages from a document

P.99 “Deleting pages from a document”

To move pages within a document to arrange the page order

P.101 “Moving pages within a document”

To move documents between boxes or folders

P.104 “Moving documents”

To copy an entire document and insert them into another document
P.106 “Merging documents”

Tips

* You can import e-Filing documents into a client computer using TWAIN Driver and File Downloader.
* You can back up or restore documents in e-Filing and various settings of e-Filing using the e-Filing Backup/Restore

Utility.
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OPERATIONS WITH THIS EQUIPMENT

This chapter describes e-Filing functions that you can operate using the control panel of this equipment.
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Printing Documents

You can print documents stored in the e-Filing using the control panel of this equipment.
P.12 “Printing an entire document”
P.15 “Test print”

M Printing an entire document
You can print an entire document.

1 Press the [FILING BOX] button on the control panel.

T\ Mew SETTING INTERRUPT COUNTER (Pew ]
O ©O&®®
Copy asc ot POWER SAVE
® 06
Scan GHL__ JKL__ MNO o
EseT
©®EO
PRINT PQRS_ TUY__ wXvZ
@ 00O =
FinG Box @ @ @ :j ©
=
L AusenTicTION © 4
(<
(@) G Y )0
L O pataIN
[/ WMoY pviDam  Arrewnon MAIN Power
— — o

2 Select the box that contains a document you want to print.
¥ eFLNG ?

BOX NUMBER | ]

001 = 002 < 003 004
PUBLIC @ @ @ @
BOX

UserBox01 UserBox02 UserBox03 UserBox04 4
008 @ 008 007 @ 008 @ 009 @ 21
UserBox05 UserBox06 UserBox07 UserBox08 UserBox09 ‘ AV

BOX SETTING

JOBSTATUS

Press or to switch the pages. You can also specify the box number (3-digit) using the digital keys.

e Password entry
When the password has been set to the selected user box, the password entry screen is displayed. In this case,

press [PASSWORD], enter the password using the digital keys or the on-screen keyboard, and then press [OK].

< TEMPLATESS

[ Select BOX.

Enter BOX Password

BOX NUMBER 001

BOX NAME UserBox01

* If you enter an invalid password several times to open the box, you may not log in for a certain period since

it will be regarded as an unauthorized access.
When “Box is locked.” appears and logging in cannot be performed, ask your administrator.

* The password input is displayed in the blank symbols.
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3 If the document is stored in a folder, select the folder and press [OPEN].

?; e-FILING 7 TEMPLATE , N

» 001 UserBox01 E ]
Document / Folder Name: Date,Time Paper Pages

B | Folderot 11,0225

|z} poci1osg 10,0432 A4 1 ;
(U -

‘4_ RETURN ‘ DELETE

BOX SETTING

If the document is stored outside of the folder, this operation is not necessary.

Select the document. To change the print settings, press [SETTINGS]. To perform
printing without changing them, press [PRINT].

vy TEMPLATE , ?

W e-FILNG

» 001 UserBox01

» Folder01

Document Name

Date, Time

Paper

Pages

|7 | poci1os0s

10, 06:04

A

4 1
e
—~
\/ !

M_ RETURN ‘ DELETE ‘ SETINGS |

[ TesteanT |

OPEN

”(i> PRNT |

Wty

If you press [SETTINGS], proceed to step 5.
If you press [PRINT], printing will start. When you want to stop printing, see “Deleting print job” in step 6.

Tip

JOBSTATUS

Press |EJEJEJ to preview thumbnail images of the documents. Select the desired one and press [OPEN] to

display its contents. Press

W eFILING

» 001 UserBox01

» Folder01

:= | to return to the list.

¥¢ TEMPLATE , rd

Bl

Document Name

DOGC110508

[+ RETURL] ‘

DELETEJ‘ SETT\NG&]‘ TESTPRH\IL”

OPEN J RS an

PRINT

BOX SETTING

JOBSTATUS

Printing Documents
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5 Change the print settings as necessary.

3 4

I | | O

_ - - -—— 2
FACE DOWN
I 18DE I SORT ‘ STACKER

“ 2SDED % FNSHNG §I ol

W MAGE
SHFT
>

>

NONE

_‘J PAGE
2;  NUMBER

2]

=
bl
@

-
_even (i) |

| JOGSIATUS .

1 6 7 8

You can operate the print settings as below. For step 3 to 8, when each button of the menu is pressed, the setting
screen appears. Perform the appropriate operations. These operations of settings are the same as the one of copy
modes. For details of the operation, refer to the User’s Manual Basic Guide.

1)

2)
3)

4)
5)
6)
7)
8)

Select the paper feeder. However, if the selected paper size is different from the actual one, the selection will be
cancelled and automatic paper selection will be applied.

Key in the number of copies to be printed using the digital keys.

Select the duplex printing mode. If you do not want to print on both sides of the paper, select [1 SIDE] in the
menu.

Select the finishing mode.

Select the receiving tray. This button is available only when the Finisher is installed.

Set the position and width of the margin.

Set the position of the date and time to be printed.

Set the position of the page number to be printed.

6 Press [PRINT].

FACE DOWN
1SDE SORT STACKER

’ 2spED [ 54 FNsHnG %l Rt
>

> >
NONE NONE NONE

MAGE TME o PAGE
SHIFT 00:05°  STAMP Z2;  NUMBER
> >

‘ CANCEL & _PRINT

1)1 S

¢ Deleting print jobs
Follow the procedure below to stop the printing of the document (delete print jobs).

1)
2)
3)
4)

Press [JOB STATUS].

On the job status menu, display the print job list or the scan job list.
Select the job you want to delete, and then press [DELETE].

The delete confirmation screen appears. Press [DELETE].

For details of deleting print jobs, refer to the User’s Manual Basic Guide.
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H Test print

You can print specified pages of the document for confirmation.

1 Press the [FILING BOX] button on the control panel.

 Powe |
_\ Meny SETTING INTERRUPT COUNTER
) (O O

Copy PPOWER SAVE

O® =
DO
Fiuin Box @ @ @ :1 V)

START
B merenn (©)
(o)
O !
I DO DaTAIN
—/ MEMORY ppinTDaa  Arrention MAaIN PoweR
— —— o

2 Select the box or folder that contains documents you want to print.
W e-FILNG ?

BOX NUMBER | ]

[ 001 002 = 003 004
PUBLIC @ @ @ @
BOX
UserBox01 UserBox02 UserBox03 UserBox04 4
-
005 @ 006 007 : 008 @ 009 @ 21
UserBox05 UserBox06 UserBox07 UserBox08 UserBox09 ‘ AV

BOX SETTING

JOBSTATUS

The instructions of the operating procedure as to selecting a box/folder are omitted, because they are the same as
those for one of printing an entire document.
P.12 “Printing an entire document”

3 Select the document you want to print, and then press [TEST PRINT].

¥ eFLNG ?
» 001 UserBox01 E (]
Document / Folder Name: Date,Time Paper Pages
Folder01 11,0225

|j DOC110509 10,0432 Ad 1
DI N
= 1
W/

e | IEE IR

(4 meToRN | oetEE ][ seTThs |

PRINT BOX SETTING b

JOBSTATUS

Tip

Press |EJEJEJ to preview thumbnail images of the documents. Select the desired one and press [OPEN] to

:= | to return to the list.

display its contents. Press
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4 Key in page numbers in [FIRST PAGE] and [LAST PAGE], then press [PRINT].

'@ e N S TEMPLATE .
TEST PRINT

Please enter a valid value

[ First Page ‘ -

4
| Last Page } ‘ 3 |

‘ All Pages_

‘ CANCEL | PRINT
¢ i s

* Select [FIRST PAGE] or [LAST PAGE], then specify the page numbers using the digital keys on the control

panel.
If you press the [CLEAR] button on the control panel, the value entered in the currently selected box can be

deleted.
* To print entire pages of the document, press [ALL PAGES].

* Deleting print jobs
Follow the procedure below to stop the printing of the document (delete print jobs).
1) Press [JOB STATUS].
2) On the job status menu, display the print job list or scan job list.
3) Select the job you want to delete, and then press [DELETE].
4) The delete confirmation screen appears. Press [DELETE].
For details of deleting print jobs, refer to the User’s Manual Basic Guide.
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Storing Documents

You can store documents in e-Filing using the control panel of this equipment.
P.17 “Copying and storing to e-Filing”
P.22 “Scanning to e-Filing”

» Store confidential documents in a user box protected by a password.

* Up to 400 documents can be stored in a box or folder, and up to 200 pages can be contained in a document.
However, the total storage capacity of e-Filing and the shared folder is approx. 84 GB. Documents can only be
stored within the storage capacity limit. The available space can be checked with the [Device] tab in TopAccess.

¢ Saving in the e-Filing is not for permanent use. Delete unnecessary documents immediately.
P.24 “Deleting Documents”

Tips

* When you store documents in user boxes and folders, you need to create them in advance.
P.26 “Creating user boxes”(Operating with this equipment)
P.44 “Creating user boxes and folders” (Operating with a client computer)

* You can set the storage period for documents in the Box Properties window in a user box. The documents will be
deleted after the specific number of days have passed.

P.54 “Modifying and displaying user box and folder properties” (Operating with a client computer)

H Copying and storing to e-Filing

You can copy and store documents in e-Filing. The e-Filing documents can be copied and stored at the same time.

* Documents, whose paper sizes are shown below, cannot be stored in e-Filing.
- Custom paper
- Non-standard size paper (multi-purpose tray)
* A document stored by “Copying and storing to e-Filing” is suitable for output, but not for importing as an image into

a client computer. To get the best image quality for importing an image into your computer, store the document by
“Scanning to e-Filing”.
P.22 “Scanning to e-Filing”

Place the original(s).
For details of placing original(s), refer to the User’s Manual Basic Guide.

2 Press [STORAGE] on the copying screen.

100 %
ORG - COPY SORT

@ ZOOM 2 mnsine
S AUTO i

»
OuUTPUT
‘@ BN J 1=1 "
o TEXT/PHOTO
& 5= ORIGINAL
‘ @ 2-SDED |f|-| ekt
» :

EDIT

JOBSTATUS

If the copying screen is not displayed, press the [COPY] button on the control panel.
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3 Press [STORE TO E-FILING].

?ﬁ COPY STORAGE , I SETTNGS ,f¥% TEMPLATE , NP
READY

1

SET

‘ COPY &FILE P
FOLDER BOX No |:|
»

BOX NAME

FOLDER NAME

DOCUMENT NAME 'J ‘DOCN 10510 |

‘ RESET ” CANCEL

4 Press [BOX/FOLDER].

@@ copy sTORAGE , | sETTNGs , l oy TEMPLATE , Jl 2
READY

e
‘ BOX / FOLDER BOX No. l:l
.

BOX NAME ‘ ‘

SET

1

FOLDER NAME ‘ ‘

DOCUMENT NAME .J ‘DOC‘ 10510 |

‘ RESET ” CANGEL

5 Select the box in which you want to store the data.

¥ eFlNG 2

BOX NUMBER: -

001 002 = 003 004
PUBLIC @ @ @ @
BOX

UserBox01 UserBox02 UserBox03 UserBox04 4
—_— —
005 @ 005 007 i 008 @ 009 @ 21
UserBox05 UserBox06 UserBox07 UserBox08 UserBox09 ‘ A4

‘ CANCEL l

Press or to switch the pages. You can also specify the box number (3-digit) the using digital keys.
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e Password entry
When the password has been set to the selected user box, the password entry screen is displayed. In this case,

press [PASSWORD], enter the password using the digital keys or the on-screen keyboard, and then press [OK].

B e-FILN
Select BOX.

Enter BOX Password

sle TEMPLATE .

I

BOX NUMBER 001

BOX NAME UserBox01

PASSWORD
»

‘ CANCEL oK

JUz SR

* If you enter an invalid password several times to open the box, you may not log in for a certain period since

it will be regarded as an unauthorized access.
When “Box is locked.” appears and logging in cannot be performed, ask your administrator.

* The password input is displayed in the blank symbols.

6 To store the original(s) in the selected box, press [OK].

@3 copy STORAGE , | SETTNGS , J| v TEWPLATE , N =
READY SET

1

» 001 UserBox01

Document / Folder Name: Date, Time: Paper Pages
» Folder01 11,0225
g DOC110509 10, 04:32 A4 1 7

e Storing in a folder
Select the folder and press [OPEN], the list in the folder is displayed. To store the original(s) in the selected folder,

press [OK].

@ copy STORAGE , | SETTNGS ,f < TEWPLATE , NG
READY =

1

» 001 UserBox01

Document / Folder Name: Date,Time Paper Pages
B | Foicerod 11,0225
g DOG1105( I 10, 0432 A4 1 3
—
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7 Change the document name as necessary, then press [OK].

?ﬁ COPY sTORAGE , | sETTNGS , lf <y TEMPLATE , Jl 2
READY

SET

1

T
‘ BOX / FOLDER BOX No.
]

BOX NAME

001

UserBox01
Folder01

‘ DOCUMENT NAME | ‘DOCH%WO |

@ ‘ RESET H CANGEL oK

FOLDER NAME

* Renaming the documents
When you press [DOCUMENT NAME], the on-screen keyboard is displayed. Key in the document name using the
keyboard and the digital keys (up to 64 characters), then press [OK].

DOC110510_
EE
| Back Space ‘ Clear

‘ﬁ" Shift J ‘ Space }
‘ CANCEL | oK !

For details of the on-screen keyboard, refer to the User’s Manual Setup Guide.

Tips

* A character string composed of "DOC", year, month and date is displayed by default. This format can be
changed in TopAccess. For details, refer to the TopAccess Guide.

» |f the same name has already been stored, a serial number (-001, -002...) will be automatically added to the
end of the file name and stored.

When the copy confirmation screen appears, press [YES] to store and print the
document. If you want to store the document without printing it, press [NO].

?ﬁ COPY STORAGE , I SETTNGS , f % TEMPLATE , NP

| CONFRMATION 2 ’

Print this document?

‘ CANCEL l T

JOBSTATUS
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9 Press the [START] button on the control panel.
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* Copying the next original
Depending on how the original is set, the confirmation screen to copy next the original may be displayed. Repeat
the procedure below as many times as necessary. When the scanning of the last page of the original finishes,
press [FINISHED].
* When the original is set on the glass, place the next original and press [YES]. When you press the [START]
button on the control panel, scanning will start.
* When the original is set on the RADF (Reversing Automatic Document Feeder) in the SADF (single feed
mode), scanning will start when the next original is set. (You do not need to press any key.)

STORAGE .I SETTNGS .M < TEMPLATE .

SCANPAGE |

JOB CANCEL ” JOBFNISH _” NEXTCOPYJ

WD SIAIUS

* Deleting scan jobs
Follow the procedure below to stop the scanning of the documents (delete scan jobs).
1) Press [JOB STATUS].
2) On the job status menu, display the scan job list.
3) Select the job you want to delete, and then press [DELETE].
4) The delete confirmation screen appears. Press [DELETE].
For details of deleting scan jobs, refer to the User’s Manual Basic Guide.
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B Scanning to e-Filing
You can scan and store documents in e-Filing. When you import an original as an image into a client computer, it is
recommended to store the document using Scan to e-Filing.

Place the original(s).
For details of placing original(s), refer to the User’s Manual Basic Guidee.

2 Press the [SCAN] button on the control panel.

N\ Menu SETTING INTERRUPT COUNTER I

Copy agc e PPOWER SAVE
OJOJO)

ReseT
_Stop
FiLNG Box @ @ @ 1: (v}

START

Aumewtcarion 7
) @ (9o

—/ MEMORY ppinTDaa  Arrention MAIN Power
o

Aatiigy G

3 Press [e-FILING].

& SCAN SETTNGS , o TEwLATE L %

Select Menul

(e, E-MALl (”j useJ

FILE
>

SCANSETTING | I

Destination File Name File Format @ PREVIEW l

[ JossTATUS |

Tip

Set [SCAN SETTING] and check [PREVIEW] as necessary. These operations are the same as the one of other
scanning functions. For details of the operation, refer to the User’s Manual Basic Guide.

Select the box or folder in which you want to store the documents. Change the
document name as necessary, then press [OK].

& SCAN SETTNGS , ] 7x TEVPLATE , B

Select Menu!!

‘ BOX / FOLDER

BOX No. 001

BOX NAME UserBox01
FOLDER NAME Folder01

‘ DOCUMENT NAME ”DGCHOSW ‘
»

‘ RESET ‘ CANCEL

N

The instructions of the operating procedure as to selecting a box/folder and changing a document name are
omitted, because they are the same as those for copying and storing to e-Filing.
P.17 “Copying and storing to e-Filing”
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5 Press [SCAN].

é SCAN SETTNGS , fl % TEMPLATE ,

Select Menu!!
Press SCAN to start scanning.

‘ ED e-FILNG H ™ FLE J

@_’ E-MAL ”2;9 UsB J

| SCANSETTNG ,

Destination File Name File Format ‘ @&l PREVEW
1 l‘a UserBox01 DOC110510 1
P

When the original is set on the RADF (Reversing Automatic Document Feeder), pressing [CONTINUE] on the
screen during scanning can start the scanning of another original after the current one.
P.23 “Scanning the next original”

The acceptable number for reserving scanning jobs differs depending on the settings. If the reserved jobs
exceed the corresponding number, the full reservation message will be displayed. In this case, wait until the
reserved scanning jobs are reduced or delete unnecessary reservations (scanning jobs) as described below.

Scanning the next original

When the original is set on the glass or [CONTINUE] is pressed during scanning on the RADF, the confirmation
screen for the next original will be displayed.

In either case, when you set the next original and press [SCAN], it will be scanned. Follow this procedure as many
as times as necessary. When all of the scanning is finished, press [JOB FINISH].

p AN SETTNGS . M <% TEMPLATE ..
SCANNING ?
To continue, Place document on glass. And press START or [SCAN]

SCANPAGE

|

‘JOBCANCEL I‘SCANSETT\N@” JOB FINISH & SCAN l

JUBSIAIUS

* You can change the scan setting by pressing [SCAN SETTING].
* You can cancel the reservation of the scanned data by pressing [JOB CANCEL].

Deleting scan jobs

Follow the procedure below to stop the scanning of the documents (delete scan jobs).
1) Press [JOB STATUS].

2) On the job status menu, display the scan job list.

3) Select the job you want to delete, and then press [DELETE].

4) The delete confirmation screen appears. Press [DELETE].

For details of deleting scan jobs, refer to the User’s Manual Basic Guide.
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Deleting Documents

You can delete documents in e-Filing using the control panel of this equipment.

e-Filing is not designed for saving documents permanently. Delete unnecessary documents immediately.

Tip
If you delete a folder or box, all the documents in the folder or box are deleted as well.

P.30 “Deleting user boxes/folders” (Operating with this equipment)
P.47 “Deleting user boxes and folders” (Operating with a client computer)

1 Press the [FILING BOX] button on the control panel.

[ Powes |
N Menu SETTING INTERRUPT COUNTER
O O
Copy - oer POWER SAVE
&) 006
Scan GHI JKL MNO R
EseT
©B®
PRINT PQRS__ TUV__ WXYZ
@ 000 ==
FILING Box @ @ @ :j (W)
=
Fax AuthETICATION ©
(
O e ()e
— O parain
[/ MMM pvioam  Arrewnon MAaIN Power
— o

2 Select a box or folder that contains a document you want to delete.
¥ e-FLNG ?

BOX NUMBER: | ]

001 002 = 003 004
PUBLIC @ @ @ @
BOX
UserBox01 UserBox02 UserBox03 UserBox04 f
—
005 @ 006 = 007 : 008 @ 009 @ 21
UserBox05 UserBox06 UserBox07 UserBox08 UserBox09 ‘ A4

BOX SETTING

JOBSTATUS

The instructions of the operating procedure as to selecting a box/folder are omitted, because they are the same as
those for printing an entire document.
P.12 “Printing an entire document”
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3 Select the document you want to delete and then press [DELETE].

?; e-FILING ¢ TEMPLATE , [N
» 001 UserBox01 E ]
Document / Folder Name: Date,Time Paper Pages
Folder01 11,0225

g DOC110509 10, 0432 Ad 1
MF 1
W/

‘4_ RETURN ‘ DELETE ‘ SETTINGS .J

PRINT BOX SETTING

TEST PRINT ” OPEN “ & PRNT j
>

H JoBSTATUS |

Tip
Press EJEJEJ to preview thumbnail images of the documents. Select the desired one and press [OPEN] to

: = | to return to the list.

display its contents. Press

When the confirmation screen appears, press [DELETE] to delete the selected
document.

W e-FILNG 2

E

Pages

» 001 UserBox|

Folder01

Are You sure you want to delete this document?
[z] poctto

1
=
= ‘ DELETE l CANCEL ] 1

(4 RETURN & PRNT j

PRINT BOX SETTING

W JOBSTATUS .

You can cancel the deletion of the selected document by pressing [CANCEL].
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Managing User Boxes/Folders

You can manage user boxes and folders in the e-Filing using the control panel of this equipment.
P.26 “Creating user boxes”

P.28 “Editing user boxes”

P.30 “Deleting user boxes/folders”

Tip
Folders can be created and edited using a client computer.
P.44 “Creating user boxes and folders”

P.50 “Renaming user boxes and folders”
P.54 “Modifying and displaying user box and folder properties”

H Creating user boxes
You can create user boxes (up to 200).

1 Press the [FILING BOX] button on the control panel.

[ Powes |
T\ Mew SETTING INTERRUPT COUNTER
) o
POWER SAVE

Fax AUTHENTICATION
© (oo

) ATAIN
MEMORY
_/ PRINTDATA  ATTENTION Main Power
=

ALY PN

2 Press the [BOX SETTING] tab, select an unregistered button numbered from “001” to
“200”, then press [SETUP].

W oFLNG ?
BOX NUMBER: 011
010 12 013 014 B
3 3 |"9® |"® |~
UserBox 10 2
W 015 017 @ 018 @ 018 @ g
’ &

>
PRINT b BOX SETTING

4 JOBSTATUS |

Press or to switch the pages. You can also directly specify the box number (3-digit) the using digital keys.
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3 Press [BOX NAME] and enter the box name.

'\ e N % TEMPLATE .
BOX SETUP ?
Enter BOX name and Password

Box No 011

‘ BOX NAVE
L
‘ }sswoao J | |
-

‘ RETYPE PASSWORD J | |
>

‘ CANCEL

JUBSIAIUS

* Entering box name
Press [BOX NAME]. The on-screen keyboard is displayed. Key in the box name (up to 32 characters) using the
keyboard and the digital keys, then press [OK]. However, the following one-byte characters cannot be used. A
space or period cannot be used at the beginning or end of the name. If these characters are keyed in, an error
message informing you of the invalid character used is displayed.
"#B & =[{}<>7[];:/\,

UserBox 11_

EE
| Back Space H Clear '

‘ﬁ" Shift ] ‘ Space J
‘ CANCEL | oK !

For details of the on-screen keyboard, refer to the User’s Manual Setup Guide.
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4 Enter the password in the [PASSWORD] and [RETYPE PASSWORD] boxes, then press
[OK].

& e N sle TEMPLATE .
BOX SETUP ?

Enter BOX name and Password.

Box No 011

‘ BOXNAME | UserBox 11
»

‘ PASSWORD ] | ****** |
>

RETYPE PASSWORD ] | ***** |
>

o
W

* Press [PASSWORD] and then [RETYPE PASSWORD]. Enter the password using the digital keys or the on-
screen keyboard. You can also create a user box without setting a password. In this case, all users can access
the user box as well as the public box.

* If you press the [CLEAR] button on the control panel, the value entered in the currently selected box can be
deleted.

* If the entered password does not meet the Password Policy, a warning message appears. Enter the correct

one.
For details of the Password Policy, refer to the TopAccess guide.
* The password input is displayed in the blank symbols.

H Editing user boxes

You can change the registered user box name and password.

1 Press the [FILING BOX] button on the control panel.

~\ Menu SETTING INTERRUPT COUNTER
) O
Copy PPOWER SAVE
® o6 O
Scan GHI_ JKL MNO R
=
@ ®©
(&) OO0 =
= OO ©
Fax AuTHENTICATION ©
I O patain
/ MEMORY PRINT D/ ATTEnTIO!
PO Armon
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2 Press the [BOX SETTING] tab, select the user box that you want to edit, and then press

[EDIT].
¥ eFLING 2
BOX NUMBER 011

010 @ o1l T’J 012 @ 013 @ 014 @ EJ
UserBox 10 UserBox 11 2
057 b 017 = 018 018 g
J \ I J P |
v

[ oewete [ el

BOX SETTING

d  JOBSTATUS ,

Press or to switch the pages. You can also directly specify the box number (3-digit) the using digital keys.

Password entry

When the password has been set to the selected user box, the password entry screen is displayed. In this case,
press [PASSWORD], enter the password using the digital keys or the on-screen keyboard, and then press [OK].

e N
BOX MODIFY

Enter BOX Password

BOX NUMBER

BOX NAME

I

011

UserBox 11

s TEMPLATE

Tips

* You can also enter the administrator password to open the user box instead of the password.
* The password input is displayed in the blank symbols.

Change [BOX NAME] / [PASSWORD] / [RETYPE PASSWORD] as necessary, and then

press [OK].

B o-FILIN
BOX MODIFY

Enter BOX name and Password.

2 TEMPLATE

BOX NUMBER

011

‘ BOX NAME _J ‘UserBoxﬁ

‘ PASSWORD

‘ RETYPE PASSWORD

I\

px4

The instructions of the operating procedure of [BOX NAME] / [PASSWORD] / [RETYPE PASSWORD] settings are

omitted, because they are the same as those for creating user boxes.

P.26 “Creating user boxes”
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H Deleting user boxes/folders

You can delete user boxes and folders.

If you want to delete a folder or a box, all documents in the folder or the box are deleted as well.

1 Press the [FILING BOX] button on the control panel.

 Power |
Menu SETTING INTERRUPT COUNTER
O
Copy POWER SAVE
ABC__ DEF
® 06
Scan GHL_ JKL__ MNO
OO =
PRINT PQRS_ TUY__ WXYZ
@ 00O ==
FiunG Box @ @ @ :j ©
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— O Damain
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2 Follow the procedure below to delete user boxes and folders.

¢ Deleting user boxes
Press the [BOX SETTING] tab, select the user box you want to delete and then press [DELETE].

¥ e-FILNG 2
BOX NUMBER: 011
010 @ o011 t’] 012 @ 013 @ 014 @ EJ
UserBox 10 UserBox 11 2
015 b 07 < 018 019 g
3 \ P I @ |
B

| Eeomie

BOX SETTING

DELETE

The instructions for the operating procedure for selecting user boxes are omitted, because they are the same as
those for editing user boxes.
P.28 “Editing user boxes”

¢ Deleting folders
Press the [PRINT] tab, select the folder you want to delete and then press [DELETE].

¥ eFLNG Jr TEVPLATE , NP
» 011 UserBox11 E (]
Document / Folder Name: Date,Time Paper Pages
B | Foicerod 10,0747
g Doc110509 J ¥ 10,07.48 A4 1 :
[  boctios10 N 10,0748 A4 3|
f

DELETE

‘ A RETURN ‘

PRINT BOX SETTING

The instructions for the operating procedure for selecting folders is omitted, because it is the same as the one of

printing an entire document.
P.12 “Printing an entire document”
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3 When the confirmation screen appears, press [DELETE] to delete the selected box/
folder.

¥ eFlLNG 2

EATMETILON n
BOX NUMBER: —
010
P ‘ A
UserBox 10 Are you sure you want to delete this box?
(Document in the BOX are also deleted)

015
P ‘ DELETE | GANGEL I
‘V

‘ DELETE

BOX SETTING

M JossTATUS |

You can cancel the deletion of the selected box/folder by pressing [CANCEL].
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2 OPERATIONS WITH THIS EQUIPMENT
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OVERVIEW OF e-Filing WEB UTILITY

This chapter provides an overview of the e-Filing web utility features.
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Before Using the e-Filing Web Utility

Before using the e-Filing web utility, check the following items on your computer.
P.34 “System requirements”

System requirements
The e-Filing web utility works with the following browsers for the Microsoft Windows operating system:

Microsoft Internet Explorer 6.0 or later (Internet Explorer 7.0 or later when IPv6 is used)

Firefox 3.5 or later

The minimum display resolution required for these browsers is 800 x 600.

When using Internet Explorer, the Privacy setting must be set to Medium on the browser. Do not set Block All Cookies
or High for the Privacy function. For instructions on the Privacy setting, see the following procedure.

Disable the popup block function of the Web browser. For instructions on how to set the popup block function, refer to
the HELP for the Web browser you are using.

e-Filing does not support access from Safari.

How to set the privacy settings in Internet Explorer
When you are using Internet Explorer, make sure that the Privacy setting is correct as follows.

1 Launch Internet Explorer and select [Internet Options] in the [Tools] menu.

{@ TopAccess - Windows Internet Explorer

\J\_/‘ [&] neep:/7192.168.0. 100/ 21AM=DEVICE

File Edit View Favorites [RPT00 Help

T:Z Favarites | i:S Delete Browsing History... Ctrl+Shift+Del
T InPrivate Browsing Ctrl+Shift+P
2 Diagnose Connection Problems

W Reopen Last Browsing Session
InPrivate Filtering Ctrl +Shift +F
InPrivate Filtering Settings i
SmartScreen Filter 3

Device Manage Add-ons

Compatibility View

Compatibility View Settings Reay

Subscribe to this Feed

Developer Tools F12 e i
- 2048 MB
Internet Options N : EHT
l’@ | Save as File & e-Fiing Space Available | 76102 MB

The [Internet Options] dialog box appears.

2 Display the [Privacy] tab and move the slider to “Medium” and click [OK].

Internet Options 2=
General | Security | Privacy | content | Connections | Programs | Advanced |
Settings 1
85 Select a setting for thMnternet zone,
777 Medium

- Elocks third-party cookies that do not have a compact
privacy policy

i - Blocks third-party cookies that save information that can

: be used to contact you without your explicit consert

- Restricts First-party cookies that save information that
<an be used o contact you without your implicit consent

[ stes | ot ][ dyanced Defaul

Pop-up Blocker

Frevent most pop-Up windows From Settings
appeating.

[ Turn an Pap-up Blocksr

InPrivate

/l' [7] Do ot collect data for use by InPrivate Filkering

g;??s\e toolbars and extensions when InPrivate Browsing

oo

The Privacy setting is saved.
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3 OVERVIEW OF e-Filing WEB UTILITY

3 Exit from Internet Explorer and launch it again before accessing e-Filing.

Exit from Internet Explorer after accessing the e-Filing web utility. To log off from the e-Filing web utility in the
user mode, click the Log-out link and then exit from Internet Explorer.
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Getting Started With the e-Filing Web Utility

This section describes how to launch and exit from the e-Filing web utility. The way to launch the utility differs depending
on whether you log in as a user or a system administrator.

P.36 “Logging in as a user”
P.37 “Logging in as a system administrator”

M Logging in as a user

There are two ways to access the e-Filing web utility:

Click the e-Filing web utility link in the TopAccess web site.
Enter the e-Filing web utility URL in the address field of your Web browser.
The e-Filing web utility URL is: http://[IP address])/?MAIN=EFILING
The [IP address] portion will be the IP address of this equipment. You can also use the DNS name of this equipment
instead of the IP address.
For example, the IP address of this equipment is 192.168.1.2
http://192.168.1.2/?MAIN=EFILING
For example, the DNS name of this equipment is mfp-00000236
http://mfp-00000236/?MAIN=EFILING

If SSL is enabled for the HTTP network service, the e-Filing web utility will also be accessed by using SSL.

When the User Management Setting has been enabled, the log-in page will be displayed when accessing the e-Filing web
utility URL. In that case, please enter your User Authentication user name and password to log in to the main page of the
e-Filing Web Utility.

TopAccess

Login with your TopAccess User Mame and Password,

User Name Userl

Pagssward [ITTTT]

Darmain dept01 E

* If you enter an invalid authentication password several times to log into the MFP, you may not be able to log in for
a certain period since it will be regarded as an unauthorized access.
* The password input is displayed in the blank symbols.

Tips

* Users can launch the e-Filing web utility to use its functions.

* Access to the e-Filing web utility will be timed out according to the Session Timer setting in the WEB General
Setting of TopAccess.

* To use the administrator’s functions of the e-Filing web utility, you must log in as a system administrator after
accessing it.
P.37 “Logging in as a system administrator”
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M Logging in as a system administrator

To log in as a system administrator, follow the steps below after launching the e-Filing web utility.

"System administrator" and "User with an administrator privilege" are defined as follows in this manual.
- System administrator:

User with the administrator role
- User with an administrator privilege:
User whose ID is "Admin"

1 Click the Log-in link located at the upper right of the page.

Documents Preferences L u:in

The Administrator Log-in page is displayed.

2 Enter the administrator password in the [Password] box and click [Login].

(“§ Electronic Filing

Administrator Login

e

Top | Help

The [Administration] tab appears in the main tabs.

If you enter an invalid authentication password several times to log into the e-Filing web utility in the
administrator mode, you may not be able to login for a certain period since it will be regarded as an
unauthorized access.

* To log off from the e-Filing web utility in the administrator mode, click the Log-out link and be sure to close
your web browser to prevent unauthorized access by other users.

Tips
* The administrator password is the same as the password that has been set in the TopAccess or touch panel

display for the administrator. The default administrator password is “123456” if you have not changed it.
* The password input is displayed in the blank symbols.
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3 OVERVIEW OF e-Filing WEB UTILITY

About the Main Tabs

The user interface of the e-Filing web utility consists of three main tabs located in the upper-right corner of the web
browser’s window: the [Documents] tab, [Preferences] tab, and [Administration] tab.

Documents Preferences Administration Logout

These main tabs enable you to display and work with your documents, set up viewing preferences, and perform
administrative functions.

P.38 “[Documents] tab”
P.40 “[Preferences] tab”
P.41 “[Administration] tab”

In addition, the Log-in link is located to the right of the main tabs which allows you to log in as a system administrator.
P.42 “Log-in link”

H [Documents] tab

The [Documents] tab is the default page and is available to all users. It consists of the Folders and Document frame, the
Menu Bar, and the Contents frame.

2 3
|
(@ Electronic Filing Login
_-E—
Document B efiing @ tems) T _
1 — {8 e-Filing

[ Public Box
5@ 001 UserDl
&A 002 UserD2
50 003 User03 Ei gi gi gi D —————T ]
& 004 UserD4 [l ] ]

50 005 UserDs
&f 006 UserD6
&g 007 Userd?

[FlPublic Bax [Floo1 userol [0z useroz [0z useros

&l &l B 2

[Floo4 usero4 [Floos useros [Foos Useros [Fo07 usero?

« 3
Top | Help
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1) Document Frame
The Document frame is an Explorer-style user interface. Use the Folders and Document frame to locate the folders
and documents with which you want to work.
In the Document frame, the following icons are displayed according to the items:
- Box Icons

Cd
il
Gl
2

This icon indicates a closed box.
This icon indicates an opened box.
This icon indicates a closed box that is protected by a password.

This icon indicates an opened box that is protected by a password.

- Folder Icons

(3
3

This icon indicates a closed folder.

This icon indicates an opened folder.

- Document Icons

B,
2

T This icon indicates a document that was stored by a print operation. When the icon is displayed on a
'Igl white background, it indicates that the document is currently in the View mode. When the icon is
displayed on a blue background, it indicates that the document is currently in the Edit mode.

W This icon indicates a document that was stored by a scan operation. When the icon is displayed on a
white background, it indicates that the document is currently in the View mode. When the icon is
displayed on a blue background, it indicates that the document is currently in the Edit mode.

|E| This icon indicates a document that was stored by a copy operation. When the icon is displayed on a
| white background, it indicates that the document is currently in the View mode. When the icon is
displayed on a blue background, it indicates that the document is currently in the Edit mode.

=8 This icon indicates a document that was stored by a fax operation via the mailbox function, fax received

liEI forward function, or Internet Fax received forward function. When the icon is displayed on a white
background, it indicates that the document is currently in the View mode. When the icon is displayed on
a blue background, it indicates that the document is currently in the Edit mode.

This icon indicates a document that was created by merging several documents. When the icon is
displayed on a white background, it indicates that the document is currently in the View mode. When
the icon is displayed on a blue background, it indicates that the document is currently in the Edit mode.

2) Menu Bar
The Menu bar is located below the main tabs: File, Edit, View, and Layout.
3) Tool Bar

The Tool bar is located below the main tabs: Send Email, Save, Test Print, Cut, Copy, Paste, Beginning, Previous,
Next, and End. These buttons provide you with a one-click access to various functions.

=

Click this button to send the selected documents as Email.

Click this button to save the document. This is enabled only when you are displaying the document in the Edit
mode.

Click this button to perform a test print.

Click this button to cut the selected documents or pages.

Click this button to copy the selected documents or pages.

Click this button to paste the items that have been copied.

Click this button to display the first items in the Contents frame.

Click this button to display the previous set of items in the Contents frame.

Click this button to display the items that immediately follow those displayed in the Content frame.

Click this button to display the last items in the Contents frame.
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4)

Contents Frame

The Contents frame displays the documents or pages with which you are working. There are also document control
buttons located below the menu bar. You can use these buttons to change the document status between the View
mode and Edit mode, and use the Contents frame to print and edit your documents.

Tip
For more information about the document control buttons, see the following section:
P.88 “About the Document Control Buttons”

M [Preferences] tab

The [Preferences] tab is available to all users. It allows you to make the default condition for document viewing and the
number of thumbnail images displayed on the screen.

1)

2)

3)

4)

5)

(§ Electronic Filing Login

Preferences

1 —— Default Document iew:  Thurnbnail view -
2 —load 8 7 thumbnails perview.

3 =[] Displaythe progress bar.

4 —5) [t
5 —

Top | Help

Default Document View
You can select the Thumbnail or List view. The system displays your documents by the selected view until you choose
another option from the View menu. The default is the Thumbnail view.

Load [number] thumbnails per view.

Use the drop-down list box to select the number of thumbnail images displayed on the screen as 4, 8 or 12. The default
is 8.

Display the progress bar.

Select the [Display the progress bar.] check box to display the progress bar when copying, cutting, or pasting the
documents or pages, deleting pages, or saving documents.

[Save]
Click this button to apply your new settings.

[Reset]
Click this button to restore the default settings.
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B [Administration] tab

The [Administration] tab allows the system administrator to manage the data in e-Filing. The [Administration] tab is only
visible if you are logged on as the system administrator.

The [Administration] tab has the following subtab:

P.41 “[Box Management] subtab”

Tip

An administrator can also set up the e-Filing notifications by using TopAccess in the administrator mode. For more
information about setting up the notifications for e-Filing, refer to the TopAccess Guide.

0 [Box Management] subtab

This subtab enables you manually to delete user boxes that are no longer required or have become corrupted. Use this
feature to restore the available hard disk space.

You can also unlock user boxes which have been locked by incorrect password entries.

@ Electronic Filing Logout
Box Management
4 —— efFiling Disk Space Available - 10142 MB
| Stored Data [ Data Type [ Dsta Size [ Remarks
[ [ [ Shared File [ 97 W [
4 —
3 —
Unlack
2 —_— ] A Box Number Box Name Used capacity Status
m [als}8 User01 57 MB
=] ooz Usern2 5KB
m 003 Userna S KB
] 004 Userl4 aome
=] 005 Usards 5 KB
s 006 User06 KB
= 007 Userg? 5KB

Top | Help

1) e-Filing Disk Space Available
This item displays the available hard disk space for storing the e-Filing data.

2) Box Number / Box Name / Used capacity / Status
This item displays a list of all user boxes. When you click a box number or box name link, the Box Properties window
opens and you can see the detail properties of the box. If the user box is locked, the lock status is displayed in the
results. To delete or unlock a user box, select the check box on the left of each property, and then click [Delete] or
[Unlock].

3) [Delete]

Click this button to delete the selected boxes. Before doing so, first select the check boxes of the user boxes that you
want to delete.

Tips

* You cannot delete the public box.
* For instructions on how to erase user boxes, see the following section:
P.112 “Erasing boxes”

4) [Unlock]

Click this button to unlock the selected boxes. Before doing so, first select the check boxes of the user boxes that you
want to unlock.

Tip

For instructions on how to unlock the user boxes, see the following section:
P.113 “Unlocking user boxes”
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M Log-in link

The Log-in link that is displayed next to the main tabs allows you to log in as a system administrator.

P.42 “Administrator log-in page”

You can perform the administrative function from the [Administration] tab that will be displayed after you log in as a system
administrator.

P.41 “[Administration] tab”

O Administrator log-in page
You must enter the system administrator password to log in as an administrator.

@ Electronic Filing

Administrator Login

{1 —rasewor eeesse
2 — o
3 —

Top | Help

1) Password
Enter the system administrator password that is same as the administrator password on the touch panel display and
TopAccess.

2) [Login]
Click this button to log in as a system administrator.

3) [Cancel]
Click this button to cancel login and return to the main page.
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HOW TO MANAGE USER BOXES/FOLDERS

This chapter provides instructions on how to manage user boxes and folders by using the e-Filing web utility.

Managing User Boxes and FOlders ...........oecciiiiiiirirccec s ss s e s s s sssmsssssssss e s e s e s mmsnssnsnnnes 44
Creating uUser boXes and FOIAEIS .........oouiiiiii et enre e 44
Deleting user DOXES @nd fOIUEIS .......c.uuiiiiii ettt e ettt e et e s e e nanee s 47
Renaming USer bOXES @nd fOIAETS..........cooiiiiii ettt e st sae e e st e e nte e e annee s 50

Modifying and displaying user box and folder Properties ............oouueiiiiie i 54




Managing User Boxes and Folders

The e-Filing web utility provides two box types: the public box and user box. Each user can create his or her own user box,
and also create one level of folder in each box.

This section explains the following operations:

P.44 “Creating user boxes and folders”

P.47 “Deleting user boxes and folders”

P.50 “Renaming user boxes and folders”

P.54 “Modifying and displaying user box and folder properties”

Tip

For a detailed explanation of the public box and user box, see the following page:
P.6 “e-Filing Features”

H Creating user boxes and folders

Each user can create his or her own user box, and also protect the box with a password, if required.
P.44 “Creating user boxes”
P.45 “Creating folders”

O Creating user boxes
This operation allows you to create up to 200 user boxes and protect each box with a password.
Tip

You can also create user boxes from the control panel. For instructions on how to create user boxes from the control
panel, see the following page:
P.26 “Creating user boxes”

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

Make sure that you are selecting “e-Filing” in the Document frame, and select [New
Box] from the [File] menu.

(@ Electronic Filing

Document
& e-Filing
[ Public Box
@ 001 Userdl 1
il 002 Usernz
5 003 User0d ﬁa ﬁa ’<a
i 004 User04 lal Gl Gl
g 005 Userds
71 006 UserDe
&A007 Userd?
001 Userol [[looz usern2 [[1003 usern3
il il aird &l

[[oo4 userns [[oos userns [[oo6 useros [oo7 usern?

< r
Top | Help

The New Box window appears.

3 Define the box properties as required and complete the operation.

1) Select a box number in the [Box Number] box.
Users cannot select existing box numbers in the [Box Number] box. Only undefined box numbers appear in this
drop-down list box.

2) Enter the box name in the [Box Name] box.
Box names can consist of any ASCII characters except: \/<>"% & =";:*?|#[]{}. Do not use a space or
period at the beginning or end of the name. The maximum size of a box name is 32 characters.

3) If you want to protect the box with a password, enter one in the [Box Password] and [Confirm Password] boxes.
The password input is displayed in the blank symbols.
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4) Click [OK].

New Box
*Required
By Mumber: 0og - %I
*Box Name: Userld
By Password: ssssss %2
Retype Passward ssssse
'3
V. |
°q4

The created user box appears in the Document frame.

Tip
Users can configure advanced properties for each box such as how long the box will retain documents, and

Email notification features.
P.54 “Modifying box properties”

U Creating folders

This operation allows you to create up to 100 folders in each box.

Only single-level folders can be created in each box. You cannot create subfolders in the folders.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box where you want to create a folder.

(¢ Electronic Filing
e et wew . |

Document B eFiing @ items)
{8 e-Filing
=/ [ Public Box
&0 001 UserDl
&f 002 UserD2
&0 003 UserD3 ﬁa
&f 004 UserD4

0 005 Userds

ga 008 UserO6
&0 007 Userd?

[FlPublic Bax [Flo01 userol
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber oot

Box Mame User1

Box Password : ‘ ssssss ’

* |f you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

4 Click the [File] menu and select [New Folder].

(¥ Electronic Filing
e e wvew oo |

Document
B e-Filing (0 k
| #g Public Box L
El 6 001 Userol Archive Document

5jl D02 UserDz Upload Archived Document
&gl D03 Userds F—
&l D04 User0a Print Document.

&l D05 Userns
éa 006 UserD&
&gl D07 Usern?

Properties

Send Email

The New Folder window appears.

5 Enter the folder name in the [Name] box and click [OK].

New Folder

B,
Name: < Folded] )

\

The created folder appears under the selected box in the Document frame.

Folder names can consist of any ASCII character except\/<>"% &=";:*?|#[]1{}. Do not use a space or
period at the beginning or end of the name. The maximum size of a folder name is 64 characters.
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H Deleting user boxes and folders

This operation allows you to delete user boxes and folders.
P.47 “Deleting user boxes”
P.48 “Deleting folders”

Tip
When the box has been protected with a password, you must enter it to delete the box and folders. Users with an
administrator privilege can delete all user boxes and folders by using their password.

4

Folders in the public box can be deleted, although you cannot delete the public box itself.

U Deleting user boxes

This operation allows you to delete user boxes. If a user box is deleted, all folders and documents in the box are also
deleted.

Tip
You can also delete user boxes from the control panel. For instructions on how to delete user boxes from the control

panel, see the following page:
P.24 “Deleting Documents”

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the user box that you want to delete.

(g Electronic Filing
File Edit View Layout

Document B e-Filing (5 items)

18 e-Filing
4 Public Bos
¥ 5@ 001 UserDl
ga 002 User02
&0 003 UserD3 63
ga 004 User04
0 005 Userds
ga 008 UserO6
&g 007 Userd?

[FlPublic Bax [Floo1 userol

3 If you select a user box which is protected with a password, the Password
Authentication window appears. Enter the password in the [Box Password] box and
click [OK].

Password Authentication

Box Mumber oot

Box hame : Userl1

Box Password asssss

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 Click the [Edit] menu and select [Delete].

(¥ Electronic Filing
et wvew oo |

Document o lEE select Al
Invert Selection
B e-Filing
El #g Public Box g“‘
opy
El 4 001 User0l
El &5 Folderol

éa 002 User02
&gl D03 User0s
éa 004 UserD4
&gl D05 Userns
éa 006 UserD&
&gl D07 Usern?

e

[CIFoldero1

The confirmation message dialog box appears.

5 Click [OK].

Message from webpage (=)

@R Do youwant to delete the item(s)?

001 User01

4\

The selected box is deleted.

U Deleting folders

This operation allows you to delete folders in the public box and user boxes. If a folder is deleted, all documents in the
folder are also deleted.

Tip
You can also delete folders from the control panel. For instructions on how to delete folders from the control panel, see

the following page:
P.30 “Deleting user boxes/folders”

Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box containing the folders that you want to delete.

(g Efectronic Filing

Document i e-Filing (5 items)

{8 e-Filing

ga 001 Userdl

& 002 UserDz
ga 003 User03 @ @
& 004 UserD4 )

ga 005 User0s

&0 006 Userds
ga 007 User0?

[Crublic Box [[loo1 usero1

48 Managing User Boxes and Folders



If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber oot

Box Mame User1

Box Password : ssssss

All folders and documents in the box are displayed in the Contents frame. n

* |f you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

4 Select the check boxes of the folders that you want to delete and select [Delete] from
the [Edit] menu.

(g Efectronic Filing

Document R Select Al
Invert Selection
i e-Filing
El dg Public Box o
Copy
El 6 001 Userol
B &3 Folder0l B

&l D02 Usernz
éa 003 User03

&gl D04 Usern4 2

& D05 User0s B

&l D06 Userds

& D07 Usern?

\derDl

The confirmation message dialog box appears.

You can also delete a folder by selecting the folder in the Document frame, clicking on the [Edit] menu and
selecting [Delete]. In that case, make sure that no documents are selected in the Contents frame. If any
documents are selected, they will be deleted instead of the selected folder.

5 Click [OK].

Message from webpage ==

@) Do vouwantto delete the item(s)?

"~ Folderdl

The selected folders are deleted.
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l Renaming user boxes and folders

This operation allows you to rename the user boxes and folders.
P.50 “Renaming user boxes”
P.52 “Renaming folders”

Tip
When the box has been protected with a password, users must enter it to rename the box or folders. Users with an
administrator privilege can rename all user boxes and folders by using their password.

You can rename folders in the public box, but cannot rename the public box itself.

0 Renaming user boxes

Do not turn off the power of the equipment when changing the box name. All folders and documents in the box will be
lost if the power is turned off while the system is saving a new name.

Tip

Users can rename user boxes from the control panel. For instructions on how to rename user boxes from the control
panel, see the following page:
P.28 “Editing user boxes”

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the user box that you want to rename.

(g Efectronic Filing
File Edit View Layout

Document & eFiling @ items)

18 e-Filing
Fa buhlic Bog
£ @ 001 UserD1
& 002 UserDz
&7 003 UserD3 @
0 004 UserD4
&7 005 UserDs

& 006 Userds
ga 007 User0?

[Crublic Box [[loo1 usero1

If you select a user box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber oot

Box Mame User1

Box Password : ssssss

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 Click the [File] menu and select [Renamel].

Electronic Filing

%

Document

B e-Filing
El M Public

Box

El 4 001 User0l
E &3 Folderol
éﬁ 002 User02
&l D03 Userds
éﬁ 004 UserD4
&gl DOS Userns
éﬁ 006 UserD&
&gl D07 Usern?

Hew Folder
Open

Archive |".\ument
Upload Archwed Document

Test Print
Print Document
Properties

Send Email

[CIFoldero1

The Rename Box window appears.

Make sure that no folder or document is selected in the Contents frame. If a folder or document is selected, it

will be renamed instead of the selected box.

5 Edit the name in the [Name] box and click [OK].

Rename Box

MNarme :

‘ Userd1

)

The confirmation dialog box appears.

Box names can consist of any ASCII characters except\/<>"% & =";:*?|#[]{}. Do not use a space or
period at the beginning or end of the name. The maximum size of a box name is 32 characters.

@ Click [OKI.

Message from webpage ===
@ Do you want to rename the item?
L ©
r‘\)

The selected box is renamed.
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U Renaming folders

Do not turn off the power of the equipment when changing the folder name. All documents in the folder will be lost if the
power is turned off while the system is saving a new name.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box containing the folder you want to rename.

(¢ Electronic Filing
File

Document B eFiing @ items)

{8 e-Filing
g Public Box
&f 001 UserD1
& 002 UserDz
&f 003 UserD3 @
g 004 UserD4
&f 005 UserDs

& 006 Userds
ga 007 User0?

[ rublic Box [[loo1 usero1

3 If you select a box that is protected with a password, the Password Authentication
window appears. In this case, enter the password in the [Box Password] box and click
[OK].

Password Authentication

Bax Mumber : on1

Box Mame : Userl1

Box Password : LTI

All folders and documents in the box are displayed in the Contents frame.

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 Select the check box of the folder that you want to rename and select [Rename] from
the [File] menu.

(@ Electronic Filing
Document
Hew Folder
B e-Filing Open
= # Public Box
El 6 001 Userol Archive [
B 3 Folder0l e IRy
&l D02 Usernz F—
&l 003 User03 Print Document.

&l D04 Usern4
& D05 User0s
&l D06 Userds
&Fl 007 Usern? Send Email

Properties

The Rename Folder window appears.

* Do not select several folders at the same time. You can only rename one folder at a time.

* You can also rename a folder by selecting the folder in the Document frame, clicking on the [File] menu and
selecting [Rename]. In that case, make sure that no document is selected in the Contents frame. If a
document is selected, it will be renamed instead of the selected folder.

5 Edit the name in the [Name] box and click [OK].

Rename Folder

Name Go\derm )

The confirmation dialog box appears.

Folder names can consist of any ASCII character except\/<>"% &=";:*7?|#[]1{}. Do not use a space or
period at the beginning or end of the name. The maximum size of a folder name is 64 characters.
G Click [OK].
Message fram wehpage ==

@ Do youwant to rename the item?
L *
v‘\\

The selected folder is renamed.
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B Modifying and displaying user box and folder properties

This operation allows you to display and modify the properties of user boxes such as the box password and maintenance
period to automatically delete documents, and Email notification settings. This operation also allows you to view and
confirm the folder properties.

P.54 “Modifying box properties”

P.57 “Displaying folder properties”

Tip

When the box has been protected with a password, you must enter it to modify the box properties. Users with an
administrator privilege can modify all user box properties and public box properties by using their password.

0 Modifying box properties

* If you want to modify the public box properties, you must first log in as the system administrator.
* You cannot modify the password of a box that any user is currently accessing.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the user box whose properties you want to display and

edit.
(¢ Electronic Filing
File Edit View Layout
Document B eFiling @ items)
{8 e-Filing

= [ Public Box
&0 001 UserDl
ga 002 User02
& 003 UserD3 63
ga 004 User04
0 005 UserDs
ga 008 UserO6
& 007 Userd?

[FlPublic Bax [Floo1 userol

If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber: 001

Boy Name : Userd1

Box Password : LLTTLT

* |f you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 HOW TO MANAGE USER BOXES/FOLDERS

4 Click the [File] menu and select [Properties].

g Electronic Filing
File Edit View

Document
lew Folder
B e-Filing Open
El M Public Box Rename
El 4 001 User0l Archive Document
B 53 Folderol Upload Archived Document
i D02 User02 i
&gl D03 Userds Print Document.

& D04 Users
&l DOS Userns
& D06 User0& AR
&gl D07 Usern? Send Email

[CIFoldero1

The Box Properties window appears. In the Box Properties window, you can see the box properties.

5 If you want to edit the box properties, click [Change Properties].

Box Properties

Ei 001 Userot

Contains. OFiletsy 1 Folder(s)

Preservation Period for Documnents : -

Email Address for Motification

Created 2011.051009.0222
Modified 2011.051009.03:22

[ 0K ] [ Change Properties %

The Change Box Properties window is displayed.

Tip

If you do not need to change the box properties, press [OK] on the above screen to complete the operation.
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6 Specify the following items as required and press [Save].

Change Box Properties

ﬂ@ 001 Userd?

[7] change Box Password
Old Password _
Mew Password : _
Confirm Mew Password: _

Change Preservation Period for Documents inside Box
[ Delets document automatically

Freservation Period for Documents : days
e-Filing Motification Events
[T) send Email when an errar occurs
[7] gend Email when job is completed

Advance automatic delete notification

eman aorose |

Advanced notification is sent hefare the date of file deletion. -[3] day(s) notice.

Change Box Password — Select this check box to edit the box password. When you select this check box, enter

the password in the [Old Password], [New Password], and [Confirm New Password] boxes.

* Old Password — Enter the current box password. This option is enabled only when you select the [Change
Box Password] check box.

* New Password — Enter the new box password. This option is enabled only when you select the [Change Box
Password] check box.

* Confirm New Password — Enter the new box password again. This option is enabled only when you select
the [Change Box Password] check box.

Tip
If you forget the old password, you can enter the administrator password in the [Old Password] box instead of it.

Delete document automatically — Select this check box to automatically delete the documents in this box. When

you select this check box, enter the number of days in the [Preservation Period for Documents] box.

* Preservation Period for Documents — Enter the number of days that the documents will be preserved. The
documents will be deleted after the specified number of days have passed. If you set this period to 1 day, the
document will be deleted automatically 24 hours later.

If a document is automatically deleted by the [Delete document automatically] function, the delete history is not
stored in the log.

For details of the logs, refer to the TopAccess Guide.

Send Email when an error occurs — Select this check box to send a notification message to the specified Email
address when an error occurs. When you select this check box, enter the Email address in the [Email Address]
box.

Send Email when job is completed — Select this check box to send a notification message to the specified Email
address when a job is complete. When you select this check box, enter the Email address in the [Email Address]
box.

Advance automatic delete notification — Select this check box to enable an Email notification message to be
sent to the specified Email address 3 days before it automatically deletes the documents. When you select this
check box, enter the Email address in the [Email Address] box.

* Email Address — Enter the Email address to which the notification will be sent.
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Tip
When the options “Send Email when an error occurs” and “Send Email when job is completed” are enabled,
you are notified of whether or not the following e-Filing operations are successfully completed.
- Scan to e-Filing
- Copy to e-Filing
- Print to e-Filing
- Fax/Internet Fax Received Forward to e-Filing
- e-Filing to Print
- e-Filing to Email

An administrator can configure the e-Filing notification setting in the TopAccess [Administration] tab -
Maintenance - Notification page. For more information, refer to the TopAccess Guide.

7 Click [OK] to close the Box Properties window.

Box Properties

Ea 001 Usernt

Contains O File(sy 1 Folder(s)

Presendation Feriod for Documents -

Email Address for Motification

Created 2011.051008:03:22

Modified : 2011.05.1003:04:43
OK[ Change Properies

U Displaying folder properties
You can only view and confirm the folder properties. No operation to modify the folder properties is available.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box containing the folder whose properties you want
to display.

(¢ Electronic Filing
File

Document B eFiling @ items)

{8 e-Filing
g Public Box
&f 001 UserD1
& 002 UserDz
&f 003 UserD3 @
&0 004 UserD4
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[ rublic Box [[loo1 usero1
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber oot

Box Mame User1

Box Password : ssssss

All folders and documents in the box are displayed in the Contents frame.

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

Select the check box of the folder with the properties that you want to view and select
[Properties] from the [File] menu.

(g Efectronic Filing

Document
New Folder
i e-Filing Open
El #g Public Box Hename
El 4 001 User0l Archive Document
] Folderol Upload Archived Document
il 002 User02 i
&gl D03 Userds Print Document.

éa 004 UserD4
&l DOS Userns
éa 006 UserD&

&gl D07 Usern? Send ErmilK

\derm

The Folder Properties window appears. In the Folder Properties window, you can view the folder properties.

* Do not select several folders at the same time. You can only view the properties of one folder at a time.

* Users can also display the properties of a folder by selecting the folder in the Document frame, clicking on
the [File] menu and selecting [Properties]. In that case, make sure that no document is selected in the
Contents frame. If a document is selected, its properties are displayed instead of the selected folder.

5 Click [OK] to close the Folder Properties window.

Folder Properties

D Folder01

Location e-Filing/Mser01iF olderdt

Contains OFile(s)

Created 2011.051009:03:38
Modified 2011.051009:03:38

A

The following information is displayed in the Folder Properties window:
Location — Displays the directory where the folder is located.
Contains — Displays the number of files the folder contains.

Created — Displays the date and time the folder was created.
Modified — Displays the date and time the folder was last modified.
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MANAGING DOCUMENTS

This chapter provides instructions on how to manage documents by using the e-Filing web utility.
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How To Manage Documents

The e-Filing web utility allows you to manage the documents stored in the e-Filing system.
This section explains the following operations:

P.60 “Displaying documents”

P.61 “Renaming documents”

P.63 “Deleting documents”

P.64 “Printing documents”

P.70 “Storing documents”

P.73 “Archiving documents”

P.78 “Sending Email”

H Displaying documents

Two ways are available to view your document image files. The document view options are:

* Thumbnail view displays several files from a selected box, folder or several pages of the selected document. This is
the default view. Use it to manage documents and files.
P.60 “Using the thumbnail view”

» List view displays file names and properties in a tabular format. Use it to manage boxes and folders containing a large
number of files.
P.61 “Using the list view”

O Using the thumbnail view

This is the default view, unless you choose a different one. It displays a small image of each file or folder (if you highlight a
box or folder in the left frame) or each page (if you highlight a document in the left frame) with the file name or page
number and a check box. Click the check boxes to select the files or pages that you want to move, copy, delete or print.
To return to the thumbnail view, go to the [View] menu and select [Thumbnail].

€' Electronic Filing Losin
Document |='D DOC110510-001 (1/3) Status : View
& e-Filing
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QO Using the list view

This view displays boxes, folders, or file names with the properties and check boxes in a list format. You may find it more
convenient than the thumbnail view for managing boxes and folders that contain a large number of files. Click the check
boxes to select a single file or multiple files that you want to move, copy, delete or print.

To display your files by the list view, go to the [View] menu and select [List].

(P Etectronic Filing Loain
File Edit View =) & By
Document [y DOC110510-001 (173) Status : View
& e-Filing
[ Public Box Pages# Format Resolution Image Size Paper Size Size
B #0071 Usern1 [ Pages 1 Copy EO00xBO0 4867 x 6922 a4 6710 KB
3 Foldero1
& 0oc110810 [ Pages 2 Copy  BO0xB00 4857 x 6922 Ev) 506 KB
|5 DOC110510-001 | [ pages 3 Copy GO0 %600 4867 « 6922 Ad 5306 KB

57l 002 Usern2
7 003 UserD3
&7 004 Usero4
7l 005 Userns
57l 006 UsarD
57l 007 Usern?
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Top | Help

B Renaming documents

This operation allows you to rename the documents.

Do not turn off the power of the equipment when changing the document name. The document will be lost if the power
is turned off while the system is saving a new name.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the document you want to
rename.

(¢ Electronic Filing

B e-Filing (B iterns)
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ga 008 UserO6
& 007 Userd?

& Aol

[FlPublic Bax [Flo01 userol

How To Manage Documents 61



If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Murmber: ool

Box Narme : Userd1

Box Password ‘ LTI ,

* |f you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

4 Select the check box of the document that you want to rename and select [Rename]
from the [File] menu.

(¥ Electronic Filing
Document
HNew Folder
B e-Filing Open
[l Public Box
E 4 001 User0l Archive 17
(7 Folderol Upload Archy ocument okr

E £OC110510 Test Print User's Manual
[FYLel RUISLELER Frint Document! e 2ty

& 002 Usern2
&l D03 Userds
& D04 Users
&gl D05 Userns Send Email
& D06 User0&

&gl D07 Usern? [CIFolderal

Properties

4;._)OC11E|51D
\ [Scan]

The Rename Document window opens.

Tip
Users can also rename a document by selecting the document in the Document frame, clicking on the [File]

menu and selecting [Rename]. In that case, even if you select the check boxes of pages in the Contents frame,
e-Filing will only rename the selected document in the Document frame.

5 Enter the document name in the [Name] box and click [OK].

Rename Document

I |

Mame : GOCHDEHJ ’

The confirmation dialog box appears.

Document names can consist of any ASCII characters except\/<>"% &=";:*?|#[]1{}. Do not use a space
or period at the beginning or end of the name. The maximum size of a document name is 64 characters.
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@ Click [OKI.

Message fram webpage (==

'9-‘ Do you want to rename the item?

[4\)

The document is renamed.

H Deleting documents
This operation allows you to delete documents from the box or folder.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the documents you want to
delete.

(¢ Electronic Filing
File

Document B eFiling @ items)
18 e-Filing

= [ Public Box
ga 001 User0l
& 002 UserDz
ga 003 User03 @ @
&g 004 UserD4
ga 005 User0s
&0 006 Userds
ga 007 UserO?

[Crublic Box [[loo1 usero1

If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Bax Murnber : ant

Box Marme : User01

Box Password [LTITT]

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 Select the check boxes of the documents that you want to delete and select [Delete]
from the [Edit] menu.

(g Efectronic Filing
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&l DOS Userns
éa 006 UserD&

&gl D07 Usern? [CIFolderal

oK1

User's Manual
Setvp Guite

DOC110510

\ [Scan]
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The confirmation dialog box appears.

Users can also delete a document by selecting it in the Document frame, clicking on the [Edit] menu and
selecting [Delete]. In that case, make sure that no pages are selected in the Contents frame. If any pages are
selected, the alert message will be displayed because pages cannot be deleted in the View mode.

5 Click [OK].

Message from webpage

@R Do youwantto delete the item(s)?

~ DOCLLS10

The documents are deleted.

M Printing documents

You can print documents and images from boxes and folders in the e-Filing web utility. The following two ways are
available to print them:

P.64 “Printing an entire document”

P.68 “Selecting test print”

Q Printing an entire document
This operation allows you to print the entire document with various print options selected.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the document that you want
to print.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Murmber: ool

Box Narme : Userd1

Box Password ‘ [LTTLL ,

* |f you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.
* The password input is displayed in the blank symbols.
Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

Select the check box of the document that you want to print and select [Print
Document] from the [File] menu.

(g Efectronic Filing

Document
New Folder
i e-Filing Open
£ Public Box Rename
3§ 001 Userdl Archive Document
] Falderol Upload Archived Document. oKr

| DOcC110510

[ DOC110510-001
&l D02 Usernz
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&gl D04 Usern4

Test Print User's Manual
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&l 005 User0s Send Email
&l D06 Userds
F 007 User0? [FIFalderol

110510
[Scan]

The Print window appears.

You can also print a document by selecting it in the Document frame and [Print Document] on the [File] menu.
However, you cannot print individual pages even if you select the check boxes of the pages displayed in the
Contents frame.
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5 Select the following print options as required and click [Print].

Print
Duplex: None - jJ Cover/Sheet [nsertion:
Mumber of Copies: 1 [F] Use Front Cover
@ Sort Copies Source: Auto Select
) Group Copies JJJJJJ Print Style: Do not print on page
Rotate Sort Copies : : [F] Use Back Cover
Paper Type: Plain - Source: Auto Select
Print Style: Do not print on page
Department Code: _ [T] Insert Pages
Paper Source: Auto Select - Saurce: Auto Select
Destination: Receiving Tray - Print Style: Do not print on page
Staple: Wone JJ Pages: _
ginding Hone JJ [T] Interleave Pages
Hole Punch: None Source: Auto Select
Page Number: Duplicate
Pasition: None - Paper Type (Insert): |Plain
Initial Page: | e | [0 scheduled Print
Year Month Date Time
Time Stamp: Date & Time : 011 5 10 .
Position: None -
Image Shift:
Position: Hone -
Shift: Margin:
Front: 1}
Back: ]

Duplex — Select whether you want the document printed on both sides of the paper. When you want to print the
document on both sides, select the Book option to print vertically in the same direction to be bound along the
vertical side of the paper so that the pages can be turned over right and left, or the Tablet option to print with a
vertical reversal to be bound along the horizontal side of the paper so that the pages can be turned over up and
down.

Number of Copies — Enter the number of copies to be printed.

The selectable range of the number of copies is from 1 copy to 999 copies.

Sort Copies — Select this option to output the document separately for each copy.

Group Copies — Select this option to output the document separately for each page.

Paper Type — Select the type of paper desired.

Department Code — Enter the 1 to 63-digit department code, if required. You must enter the department code to
print a document if the department code is enabled on the equipment.

Paper Source — Select the paper feed source. Select a paper source that correlates with the printing size.
Destination — Select the tray to which the document will be output.

Staple — Select whether the document is to be stapled or not. When you want to staple the document, select how
it will be done.

* “Staple” is enabled only when the Finisher is installed.
» If you enable the Staple option after enabling the Interleave Pages option, the latter will be automatically
disabled.

Page Number - Position — Select whether the page numbers are to be printed on the pages. When you want to
print the page numbers, select where it will be done.

Page Number - Initial Page — Enter the first number that applies to the first page of the document. When the
Cover/Sheet Insertion - Use Front Cover option is enabled, the front cover is counted as the first page, and the first
page of the document is counted at the second page.

Time Stamp - Position — Select whether the print time is printed on each page or not. When you want to print the
time stamp, select where you want it to be done.

Image Shift - Position — Select whether the printed images are to be shifted or not. When you want to shift the
printed images, select it to be done.

Shift Margin - Front — Select the width of the margin that is to be added to the side when the printed images are
shifted.
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Shift Margin - Back — Select the width of the margin that is to be added to the opposite side when the printed
images are shifted.

Cover/Sheet Insertion - Use Front Cover — This option sets front cover printing which allows you to insert or
print a cover on a sheet fed from a different tray than the Paper Source option. To enable front cover printing, select
the check box and specify the location from where the cover sheet is to be fed and the print style to be used.
Cover/Sheet Insertion - Use Back Cover — This option sets back cover printing which allows you to insert or
print a cover on a sheet fed from a different tray than the Paper Source option. To enable back cover printing,
select the check box and specify the location from where the cover sheet is to be fed and the print style to be used.
Cover/Sheet Insertion - Insert Pages — This option sets sheet insertion printing which allows you to insert a
sheet between pages, or print a specific page on a sheet fed from a tray other than the Paper Source option. This
option is useful when you want to insert a blank sheet between chapters, or when you want to print chapter cover
pages on different paper. To enable sheet insertion printing, select the check box and specify the location from
where the inserted sheets are to be fed and the print style to be used. Then enter the page numbers you want to
insert, separating them with commas if multiple pages are specified, in the [Pages] box.

Cover/Sheet Insertion - Interleave Pages — This option sets the interleaving page feature that is useful when
you want to insert paper of a different type (or from another source) between every page of your print job. For
example, you could use this option to insert blank, colored sheets between overhead transparencies. To enable
interleaving pages, select the check box and specify the location from where sheets are to be fed. Also, select the
[Duplicate] check box if you want to print the previous page images on the inserted sheet.

If you enable the Interleave Pages option after enabling the Staple option, the latter will be automatically
disabled.

Paper Type (Insert) — When you select the Multi-Purpose Tray (MPT) option for the paper source of either the
Use Front Cover, User Back Cover, Insert Pages, or Interleave Pages option, select the paper type for the paper
fed from the multi-purpose tray.
Tip
When both the user management and department management settings are enabled, the quotas that are
allowed for the department and user will be displayed in the upper right-hand area of the page.

Scheduled Print — Select this option to print a job at a future date and time. When this option is selected, set the
date and time to print the job in the [Date & Time] box.
Tips

* Clicking [Print] prints the document, and the print result window is displayed.
* Clicking [Cancel] closes the Print window without printing.
* Clicking [Reset] restores the default print properties settings.

6 Click [Close] to return to the [Documents] tab page.

When you want to cancel a job before printing is complete, access TopAccess, click the [Job Status] tab >
[Print], select the job and press [Delete].
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0 Selecting test print
This operation allows you to simply print a copy of a document by using the default print properties settings.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the document that you want
to print.

(¢ Electronic Filing

Document B Filing (F itams)

{8 e-Filing
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumnber on1

Box Mame User01

Box Password ‘ ssssss ’

* |f you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

4 Select the check box of the document that you want to print and select [Test Print] from
the [File] menu.
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B e-Filing (0
[l Public Box fename
El 4 001 User0l Archive Document

(77 Foldernl Upload Archived Document. oK1
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User's Manual
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Properties

4 DOC110510
k [Scan]

The Test Print window appears.

You can also perform test printing by selecting a document in the Document frame and then selecting [Test

Print] on the [File] menu. However, you cannot print individual pages, even if you select the check boxes of the
pages displayed in the Contents frame.
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5 Select whether to print all pages of the document or only specified pages and click
[Print].

Test Print

@ Al Pages Department Code

51 -3 Pages |

All Pages — Select this option to print all pages of the document.
[first page number] - [last page number] Pages — Select this option to specify the pages to be printed. When
this option is selected, enter the numbers of first page and last page to be printed in each box.

Department Code — Enter a department code. This must be entered only when the department code is enabled H
on the equipment.

Tips

* When both the user management and department management settings are enabled, the quotas that are
allowed for the department and user will be displayed in the upper right-hand area of the page.

* Clicking [Print] prints one copy of the document and the print result window is displayed.

» Clicking [Cancel] closes the Test Print window without printing.

6 Click [Close] to return to the [Documents] tab page.

When you want to cancel a job before printing is complete, access TopAccess, click the [Job Status] tab >
[Print], select the job and press [Delete].
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l Storing documents

From an application that runs under the Windows operating system, you can send a document as a print job to e-Filing
with the printer driver.

You can store your documents in the public box or in a user box.

P.70 “Saving a print job in the public box”

P.71 “Saving a print job in a user box”

When you store a document in e-Filing by using the printer driver, the printed image (not the original document in your
computer) will be stored in e-Filing.

Tips

For more information about the printer driver, refer to the User’s Manual Basic Guide.

For a detailed explanation of the public box and user box, see the following page:

P.6 “e-Filing Features”

You can also store a scanned document in e-Filing by using the control panel. For details, see the following page:
P.17 “Storing Documents”

U Saving a print job in the public box

1
2

Open the document that you want to store in the box.

Click the [File] menu and select [Print] in your application.
The [Print] dialog box appears.

Select the printer driver of the equipment to be used and click [Preferences].
The [Printing Preferences] dialog box appears.

Tip
The procedure for displaying the [Printing Preferences] dialog box for the printer driver may be different

depending on the application that you are using. Refer to your application manual about displaying the [Printing
Preferences] dialog box.

Select the print job type on the [Basic] tab.
1) Select [Store to e-Filing] in the [Print Job] box.
2) Select other print options as required.

3) Click [OK].
== OKIMCTT0{PS) Printing Preferences ==
Basic | Finishing | Papet Handing | Image Qualiy | Effect | Others | Templates|
Print Job: Original Paper Sige: |
=] NormalPrint .. Letter (8 12 11) -
[ Normal Print Print Paper Size: [F] Image Scale:
(O Scheduled Print Same as Original Size «| (100 %{25-400)
& Private Print
Eli: Proof Print Paper Saurce:
<% Print to Overlay File -
ol - Paper Type:
< Store to e-Filing
S Multile oo ] ) 1
0% ' Destination:
= | P
Lo i
J_h 23 1'_]1 23
5]
Profile:
e =
Orientation
Save Profile Delete @ Paortrait (@ Landscape
Restore Defaults 2 ol

Cancel Aoty Help |
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5 Select [Public Box] to save the print job and click [OK].
Store to e-Filing 5

Store to Pazsword

000 Fublic Be &

Box Folder:

[ Print

 —T— [ Gancal

Tips

* If you print a job as well as saving it in the public box, select the [Print] check box.
* |f you want to save a print job in a specified folder, enter its name in the [Box Folder] box.
To save data in an existing folder, enter its folder name in the [Box Folder] box.
To create a new folder and save data in it, enter the new folder name in the [Box Folder] box.

Click [OK] or [Print] to save the print job.
The print job is saved in the public box.

U Saving a print job in a user box
1 Open the document that you want to store in the box.

2 Click the [File] menu and select [Print] in your application.
The [Print] dialog box appears.

3 Select the printer driver of the equipment to be used and click [Preferences].
The [Printing Preferences] dialog box appears.

Tip
The procedure for displaying the [Printing Preferences] dialog box for the printer driver may be different

depending on the application that you are using. Refer to your application manual about displaying the [Printing
Preferences] dialog box.

4 Select the print job type on the [Basic] tab.
1) Select [Store to e-Filing] in the [Print Job] box.
2) Select other print options as required.
3) Click [OK].

1= OKTMCTTOPS) Printing Preferences ==

Basic | Finishing | Papet Handing | Image Gualty | Effect | Others | Templates|

Print Jab: Original Paper Size:
=l._NosmalPrin [ Letter (8 L/2x L1") -

El  Normal Print

Print Paper Size: [ Image Scale:
O Scheduled Print Same as Original Size ~| [100 24(25-400)
& Private Print
El* Proof Print Paper Source:
15 b =
<€ Print to Overlay File o
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< Store to e-Filing
E+ Multiple Job Ty B
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= |
5 | o
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5|
i s i =] (1999
Profile:
Orientation:
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Restare Defaults gpy Colon
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5 Select a user box to save the print job.
1) Select the desired user box number from the [Store to] box.
2) Enter the password for the user box in the [Password] box.
3) If you print a job as well as saving it in the user box, select the [Print] check box.

4) Click [OK].
Store to e-Filing ==
Store to: Password:
sevsee
Box Folder %
Folderl 1 2

Iﬁm
3 CE [ Ganeel
|

ar

Tip

If you want to save a print job in a specified folder, enter its name in the [Box Folder] box.
To save data in an existing folder, enter its folder name in the [Box Folder] box.
To create a new folder and save data in it, enter the new folder name in the [Box Folder] box.

If the Enable SNMP Communication option is enabled on the [Configuration] tab, only the user boxes that have
been set up will be displayed in the drop-down list box.

6 Click [OK] or [Print] to save the print job.

The print job is saved in the specified user box.
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B Archiving documents

The e-Filing web utility allows you to archive the documents stored in e-Filing and download the archived files to your
computer. These files can also be uploaded from your computer to e-Filing in the equipment, or other equipment of the
same series.

P.73 “Downloading an archived document”

P.76 “Uploading archived documents”

The archive files are compatible with the same series of the MFP.

U Downloading an archived document

You can archive the documents in the box and download it to your computer. Use this feature to create a back-up file of H
your documents in e-Filing.

The following procedure describes an example of how to download an archived document when using Microsoft Internet
Explorer.

* The archived file contains all the documents you have specified to the archive, but you cannot open the documents
on your computer.

* You can create an archived file that contains multiple documents in the same folder or the same box.

* You cannot create an archived file that contains more than 2 GB of data.

* Do not close the main window and child window by clicking [X]. If you do, downloading the archived documents
becomes impossible. If you close the window by clicking [X] by mistake, turn the power to the equipment off and
then on again.

Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the document that you want

to archive.
(¢ Electronic Filing
Document i eFiling (3 items)
18 e-Filing

= [ Public Box
ga 001 Userdl
&0 002 UserDz
ga 003 Userd3 @ @
0 004 UserD4
ga 005 Users
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ga 007 UserO?
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Murmber: ool

Box Narme : Userd1

Box Password ‘ [LTTLL ,

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

4 Select the check box of the document that you want to archive and select [Archive
Document] from the [File] menu.
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Document
New Folder

B e-Filing Open
@ Public Box Rename
5l 2 001 User0l

(] Foldero1
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[FREIS S URER print Document S ome

&gl D02 Usernz
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&gl D04 Usern4
&l 005 User0s Send Email
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Upload Archived D(k’n:ﬂl

Properties

[FIFalderol
110510
[Scan]

1

The confirmation dialog box appears.

Users can also archive a document by selecting the document in the Document frame, clicking on the [File]
menu and selecting [Archive Document]. However, you cannot archive individual pages, even if you select the
check boxes of the pages displayed in the Contents frame.

5 Click [OK] to start archiving the document.

Message from webpage

@ ~ § Do youwantto archive the document?
Y This process may take some time.
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The Archive Document window appears. During archiving, you can quit the process by

clicking [Cancel].

Archive Document

This process may take some time.
Please wait while the document is compressed and a downloadable archive file is created

65 %

Cancel

When archiving the document has been completed, “Your document has been archived successfully” is displayed.

Do not perform any operation while the e-Filing web utility is running busy.

Archive Document

Your document has been archived succesatully.

Please clickthe link below.

ou can now downlaad the archived file onta your systam

The link will launch a file download dialog allowing you 1o selecta name and path for the zip file
File Name: 20110510_15442 zip

Created 05:10:2011 09:40:42
Size (KB):  21MB

Close

The [File Download] dialog box appears.

8 Click [Save].

File Download ==

Do you want to open or save this file?

g Name: 20110510_15442.zip
Type: Compressed zipped) Folder, 21,9MB
From: 157.69.73.250

Open ] [ Save [ cancel
Aluays ask before opening this ype of fle

[~ ’\I ‘while files from the Internet can be useful, some files can potentially
\a harm your computer. [ you da not trust the source, do not opsn or
i save this file. What's the risk?

The [Save As] dialog box appears.

7 Click the file name link to download the archived file.

Save As ==
@@v\!mshmp v [ 43| [ search Desktap o
Organize »  New folder E- @
AT Favarites ST | braries .

P Desktop ——| system Folder
==l
I Downlaads
] Recent Places Usertn1
& System Folder |
Libraries i
= A Computer
=SS System Folder
(M Camputer =
. N
€l Network ‘ System Folder
i Drivers
#)  File folder
File name:  20110510_15442 -
Save as type: |Compressed (zipped) Folder -

This starts downloading the file.

9 Locate the folder where you want the archived file saved and click [Save].
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10 Click [Close].

Archive Document
Your document has been archived successfully.

Please slick the link below

You can now download the archived file onto your systern

The linkwill launch a file download dialog allowing you to select a name and path for the zip file.
FileMame - 20110510, 15442.210

Created:  0510:2011 09:40:42

Size (KB):  21M8

0 Uploading archived documents

If you have an archived file that has been downloaded from the equipment to your computer, you can upload it to e-Filing.
When you upload the archived file, the file is automatically extracted and documents will be created in the box specified.

* If the same name document already exists in the box, the extracted document will be renamed by adding a 3-digit
number to the original name.

* Do not close the main window and child window by clicking [X]. If you do, uploading the archived documents
becomes impossible. If you close the window by clicking [X] by mistake, turn the power to the equipment off and
then on again.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder where you want to upload the archived
documents.

(¢ Electronic Filing
File

Document B eFiing @ items)

{8 e-Filing
= [ Public Box
&0 001 UserDl
&f 002 UserD2
& 003 UserD3 ﬁa
&f 004 UserD4
&0 005 UserDs
&F 006 UserD6
&g 007 Userd?

[FlPublic Bax [Flo01 userol

If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumnber onz

Box Marme : User02

Box Password sassss

* |f you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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5 MANAGING DOCUMENTS

4 Select [Upload Archived Document] from the [File] menu.

P Electronic Filing
File Edit View

Document
lew Folder
B e-Filing Open
[ Public Box Rename
A 001 User01 Archive Document
El 2 002 User02
] Folderoz e k
&gl D03 Userds Print Document.

& D04 Users
&l DOS Userns
& D06 User0&
&gl D07 Usern? Send Email

Properties

[CIFolderoz

The Upload Archived Document window appears.

5 Click [Browse].

Upload Archived Document

farchived File : \ Browse [

The [Choose File] dialog box appears.
6 Select the archived file to be uploaded and click [Open].

@v\y b Archive » ~ [ 4 ||| Search Archive 2]

Organize »  Newfolder fE~ O @

9 Favorites 20110510_15442
B Desktop J Compressed (zipped) Folder
|18 Dawnloads '

% Recent Places

54 Libraries
18 Computer

€l Network

File name: 20110510_15442 ~ | AllFiles (") &

W2

This will return you to the Upload Archived Document window, and the folder path of the selected file will be
displayed in the [Archived File] box.

7 Click [OK].

Upload Archived Document

Wrehived File @ Ch\Users\Userl01\DesktoptArchivels | Browse.

E 0K Cancel

14\

The confirmation dialog box appears.
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8 Click [OK] to start uploading the archived file.

IMessage fram webpage @

‘.-"' § Do you want to upload the archived file?
"' This process may take some time.

QK '\\l [ Cancel
Ia
\ ]

If you select an archived file unsupported in your model or a file other than an archived one, an error message
appears. In that case, select the correct archived file and try again.

The Upload Archive Document window shows the process of uploading. During the
uploading process, you can quit uploading by clicking [Cancel].

Upload Archived Document
This process may take some time.
Please wait while the archived file is uploaded to the selected box.

25 %

[ ]

When uploading the archived file has been completed, “Your document has been uploaded successfully” is
displayed.

Do not perform any operation while the e-Filing web utility is running busy.

10 Click [Close].

Uplead Archived Document

Your docurnent has been uploaded successfully.

The documents are added to the selected box.

H Sending Email

You can send the selected documents as Emails from the e-Filing web utility.
When you perform this function, the equipment creates an Email with the selected documents as an attached file and
sends the Email directly from the equipment.

* To use the Send Email function, the Email configuration of the equipment needs to be set by the network
administrator.

* When using a multifunctional digital system (MFP), you can send e-Filing documents as Emails only when they
have been saved under the conditions noted below. Check the document properties before sending the
documents.

- Documents which were saved with the copy function of the equipment in the TEXT/PHOTO or TEXT mode
- Documents which were saved with the scanning function of the equipment
- Documents which were saved with the received fax/Internet Fax transferred function

1 Click the [Documents] tab.
The [Documents] tab page is displayed.
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2 In the Document frame, select the box or folder containing the document that you want
to send as an Email.

(¢ Electronic Filing

B e-Filing (B itemns)

ga 001 User0l
& 002 UserDz
ga 003 User03
&g 004 UserD4
ga 005 User0s
&0 006 Userds
ga 007 UserO?

¥ &l

[ rublic Box [[loo1 usero1

If you select a box that is protected with a password, the Password Authentication H
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumnber on1

Box Marme : User01

Box Password ‘ sassss ,

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

4 Select the check box of the document that you want to send as an Email and select
[Send Email] from the [File] menu.

(¢ Electronic Filing
Document
New Folder
B e-Filing Open
@ Public Box B
Bl Z# 001 User01 Archive Document
(] Folderol Upload Archived Document

E poc110s1n Test Print User's Manual
[Tl SULS LENIER Print Document taunlue

éa 002 User02
&l 003 Userds
éa 004 UserD4
&l DOS Userns
éa 006 UserD&
&gl D07 Usern?

Properties

4 DOC110510
k [Scan]

The Send Email page is displayed.

Tips

* Users can also send a document as an Email by selecting the document in the Document frame, clicking on
the [File] menu and selecting [Send Email].

* Users can also send up to 100 individual pages or documents by selecting the check boxes displayed in the
Contents frame.
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5 Specify the following items as required and click [Send].

Send Email
[ TO: Destination Setting ]
\To Destination | single \
CC: Destination Setting
e Destinstion | |
[ BCGC: Destination Setting ]
|Bec: Destination | |
Email Setting
*Reguired
@ Send data from (Device name) (Bax Infa )
Subject o]
[T el the dte sl time to the subject
*From Address Uzed1@example.com
From Mame Uszerd1
Body
File Format PDF{Multi) =
Encryption
UserPassword |eesesessesseesssees Retype Passwird (eesseessssseesnees
——————
Master Pa ord | Retype Password |ssssssssssssssssss
Encryption Level  128-bit AES -
IR Authority
[¥] Printing
[#] change of Documents
Content Copying or Extraction
[¥] Content Extraction for accessibility
@ DocyMMDDOYYMMDD is a date)
File Name () Original Document Name
Fragmert Message Size Mo Fragrentation +

[TO: Destination Setting] — Click this button to specify the destination. When you click this button, the Recipient

List page appears. For instructions on how to specify the destination, see the following section:

P.82 “Destination setting”

[CC: Destination Setting] — Click this button to specify the CC destination.

[BCC: Destination Setting] — Click this button to specify the BCC destination.

Subject — This option sets the subject of the Email documents. Select [Send data from (Device name) (Box Info.)]

set by default, or enter the desired subject in the box. When you want to add the date and time to the subject,

select the [Add the date and time to the subject] check box.

From Address — Enter the Email address of the sender. When the recipient replies, the message will be sent to

this Email address.

From Name — Enter the sender’s name of the Email document.

Body — Enter the body message of the Email document. You can enter up to 1000 characters (including spaces).

File Format — Select the file format to which the received document will be converted.

* TIFF (Multi) — Select this option to save the scanned images as a multi-page TIFF file.

* TIFF (Single) — Select this option to save the scanned images separately as single-page TIFF files.

* PDF (Multi) — Select this option to save the scanned images as a multi-page PDF file.

* PDF (Single) — Select this option to save the scanned images separately as single-page PDF files.

* XPS (Multi) — Select this option to save the scanned images as a multi-page XPS file.

* XPS (Single) — Select this option to save the scanned images separately as single-page XPS files.

* JPEG — Select this option to save the scanned images as JPEG files. This option is selectable only when you
have scanned the images with either [FULL COLOR] or [GRAY SCALE].

» |f the forced encryption setting is enabled, only [PDF (Multi)] and [PDF (Single)] are selectable for the file
format. For the forced encryption function, refer to the User’s Manual Advanced Guide.

¢ Files saved in the XPS format can be used in Windows Vista, Windows 7, and Windows Server 2008, or
Windows Server 2003 SP2 or later versions with Net Framework 3.0 installed.

Encryption — Set this option for encrypting PDF files if you have selected [PDF (Multi)] or [PDF (Single)] as the
file format setting.

* Encryption — Select this check box if you want to encrypt PDF files.

* User Password — Enter a password for opening encrypted PDF files.
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* Master Password — Enter a password for changing the encryption PDF setting.

Tips

» |f the forced encryption setting is enabled, you cannot clear the [Encryption] check box. For the forced
encryption function, refer to the User’s Manual Advanced Guide.

* The user password and the master password are not set at the factory shipment. If the master password is
to be set, ask your network administrator.

* A password must be entered in one-byte alphanumeric characters. The minimum and maximum numbers of
characters allowed are 1 and 32.

¢ The user password must differ from the master password.

* These passwords can be re-entered only by an authorized user. Users cannot change the settings of the
[Encryption Level] box and the [Authority] box noted below if they are not authorized to change the master
password. Ask the administrator about resetting these passwords.

* For details of the encryption setting, refer to the User’s Manual Advanced Guide.

* Encryption Level — Select the desired encryption level.
- 40-bit RC4 — Select this option to set an encryption level to the one compatible with Acrobat 3.0, PDF
V1.1.
- 128-bit RC4 — Select this option to set an encryption level to the one compatible with Acrobat 5.0, PDF
V1.4.
- 128-bit AES — Select this option to set an encryption level to the one compatible with Acrobat 7.0, PDF
V1.6.
* Authority — Select the check box of the desired type for the encrypt PDF authority.
- Printing
- Change of Documents
- Content Copying or Extraction
- Content Extraction for accessibility
File Name — Select how the attached file will be named. Select [DocYYMMDD] to name it as described, select
[Original Document Name] to use the original document name, or you can enter the desired file name in the field.
Fragment Message Size — Select the size of the message fragmentation.
Department Code — Enter the department code if required.

6 Click [Close].

(¥ Electronic Filing

Send Email

aur document has been sent successfully.,
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U Destination setting

On the Recipient List page, you can specify up to 400 destinations to send e-Filing documents as Email.
You can specify the recipients by entering the Email addresses manually, selecting the recipients from an address book,
selecting the recipient groups from an address book, or searching the LDAP server for recipients.

If [LDAP Authentication] is selected in [Authentication Type], you can choose only destinations that are registered in
the authenticated LDAP servers. For details of the LDAP Authentication option, refer to the TopAccess Guide.

P.82 “Entering recipients manually”

P.83 “Selecting recipients from an address book”
P.84 “Selecting groups from an address book”
P.85 “Searching the LDAP server for recipients”
P.86 “Removing contacts from the recipient list”

Entering recipients manually

Follow the steps below to manually add a recipient to the Recipient List.
1 Click [Destination Setting] to open the Recipient List page.
9 Click [New].

Recipient List

[ Cancal ][ Address Book H Address Group ” Search ] Delete
|i||vm I'w |Destmatmn

The Contact Property page is displayed.
3 Enter the Email address of the recipient in the [Destination] box and click [OK].

Contact Property

*Req 12

*Destination | UseD2&example.com N

1

The entered recipient is added to the Recipient List page.
4 Repeat steps 2 and 3 to add all the recipients as required.
Tip

You can remove contacts once added to the recipient list before saving the destination settings.
P.86 “Removing contacts from the recipient list”

5 Click [Save].

Recipient List

[ Cancel ]’ Address Book H Address Group ][ Search ]
| ame

Destination

B | User002@example com

The contacts are added as the destinations.
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Selecting recipients from an address book

Follow the steps below to select recipients from an address book.

1 Click [Destination Setting] to open the Recipient List page.
2 Click [Address Book].

Recipient List

[ Cancal ][ Addrass Enn{ H Address Group ” Search ] Delete

(e

|Dest|nat‘§gs

The Address Book page is displayed.

3 Select the Email check boxes of the users you want to add and click [Add].

Address Book

Group Al Groups ~

A\

il wllame

Email Address

Lizert0

UserD1 0g@example.com

Lzer00g

UserDSg@example.com

Uzer008

UserD0ag@example.com

Lizer007

UserDOT @example.com

Lizer008

UserD0E@example.com

Lizer00s

User005@example.com

Lizer0n4

User004@example com

Liser003

User003@example com

Liseron2

User002@erample com

Lizer0o

= EHEE =] =) =)

UserDin @esxample.com

ofthis page

The selected recipients are added to the Recipient List page.

Tips

* |f you want to sort recipients into specific groups, select the desired group name in the [Group] box.
* You can remove contacts once added to the recipient list before saving the destination settings.

P.86 “Removing contacts from the recipient list”

4 Click [Save].

Recipient List

Cancel ]’ Address Book H Address Group ][ Search ]

] ame

Destination

Uiserona

User004g@example com

User003@example com

m]
[ |Usero0z
=]

Lzer002

UserD02@example. com

The contacts are added as the destinations.
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Selecting groups from an address book

Follow the steps below to select groups from an address book.

1 Click [Destination Setting] to open the Recipient List page.
2 Click [Address Group].

Recipient List

[ Cancal ][ Address Book H Address Group ” Search ] Delete
N
|i||vName |Destmatmn W

The Address Group page is displayed.

3 Select the group check boxes containing the desired recipients and click [Add].
Address Group

A\

|Grnup|maug Mame

Fl \eroupos

Sroupz

o]
Sroup0t

Pop ofthis page

All recipients in the selected groups are added to the Recipient List page.
Tip

You can remove contacts once added to the recipient list before saving the destination settings.
P.86 “Removing contacts from the recipient list”

4 Click [Save].

Recipient List

[ Cancal ][ Address Book H Address Group ” Search ]

K] ame Destination

B |emupm Group

The contacts are added as the destinations.
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Searching the LDAP server for recipients

Follow the steps below to search the registered LDAP server for recipients.

Tip
To search the LDAP server for recipients, an administrator must set up the directory service by using TopAccess in the
administrator mode. For details, refer to the TopAccess Guide.

1 Click [Destination Setting] to open the Recipient List page.
2 Click [Search].

Recipient List

[ Cancel ][ Address Book H Address Group ][ Sean:hA]
|
|i||vName |De5|inat\un Vw

The Search Contact page is displayed.

Specify the search condition.

1) Select the directory service name that you want to search in the [Directory Service Name] box.
2) Enter the search terms in the fields that you want to search.
3) Click [Search].

Search Contact

Entera -k . me or Email address to search for a contact.

Directary Service Name  LDAPO1 -
First Narne %1

Last Narre User
Email Address
Fax Mumber

cormpany

Cepartment [

TopAccess will start searching the LDAP server for recipients, and the Search Address List page will display the
results.

Tips

* If you select the model name of the equipment in the [Directory Service Name] box, you can search the
address book of the equipment for recipients.

* TopAccess will search for the recipients that match the entries.

* Fillin at least one of the fields to perform a wild-card search.
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4 Select the Email check boxes of the users you want to add and click [Add].

Search Address List

= | &

ame company department Email Address
Usi 010 User01 0i@example.com

Us{ 009 UserD09g@example.com

Us 008 User00&@example com

Us¢ 007 User007@example com

Us( 008 User00E@example com

Us( 005 User005@example com

User004g@exampie com

Us( 003 User003g@exampie com

Us{ 002 UserD02g@example. com

Us{ 001 User00 @example. com

HEEEEEEEEE =

of this pane

The selected recipients are added to the Recipient List page.
Tip

You can remove contacts once added to the recipient list before saving the destination settings.
P.86 “Removing contacts from the recipient list”

5 Click [Save].

Recipient List

Save [ Cancal ][ Address Book H Address Group ” Search ]

K] ame Destination

[ |Usernng User004g@example com
[ |Usernos User003@example com
[ |Usernoz User002@example com

The contacts are added as the destinations.

Removing contacts from the recipient list

Select the check boxes of the contacts that you want to remove from the recipient list,
and click [Delete].

Recipient List
[ Cancel ]’ Address Book H Address Group ][ Search ] { Delete |
vhme Destination

Use 004 UserD04g@example.com

User003@example com

ElEIE]S
=
5
2

Use 002 User002@example com

The selected contacts are removed from the recipient list.
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EDITING DOCUMENTS

This chapter provides instructions on how to edit documents by using the e-Filing web utility.

About the Document Control Buttons............coccieiniisrr s 88
Editing With Pages in Your DOCUMENES ........coceeeeiiiiiiiriricecccss e s e s re s ss e s e s e mmnmn s snenenes 89
Displaying document and Page ProPEIrLIES .........eiiiriie ittt e 89
Copying pages from one document 0 @NOthEr ...........coociiiiiii e 90
Copying pages from a document to @ DOX OF fOIAET...........cooiiiiiiii e 95
Deleting pages from @ AOCUMENT............uiiiiii ittt e e e e e e e e e e e e e s e e e e eesnsbeeaeesnnsraeaaaeanes 99
Moving pages Within @ AOCUMENT .........ooi it e e e e e e e e e e e e e e es e s e s e taeaeeteesteeeeeeeeeeeaeeesanannsnsnnnes 101
Moving and Merging DOCUMENLS...........cccccemmiiiiiiniieere s 104
[0V TaTe e [oTeN T4 gT=T o | OO PUSPPRRPN: 104
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About the Document Control Buttons

The e-Filing web utility allows you to make changes to your stored documents before you print them.

Three document control buttons are provided in the e-Filing web utility: [Edit], [Save], and [Cancel].

These buttons are displayed at the top of the Contents frame when you select a document in the Document frame. The
buttons displayed vary depending on the document status.

» [Edit] — Click this button to start editing the document. Only this button is displayed when you are in the View mode,
where the document status indicates “View”. When you click [Edit], the document status will be changed to “Editing”,
[Save] and [Cancel] appear instead of [Edit], and you can edit the document. If you click this button when the
document status indicates “In Use”, you cannot enter the Edit mode and the message “The Document is being used.
Please try again later” is displayed.

» [Save] — Click this button to save the document that you have edited. This button is displayed only when you are in
the Edit mode, where the document status indicates “Editing”. When you click this button, the document is saved and
returns to the View mode.

¢ [Cancel] — Click this button to return to the View mode without saving the document. This button is displayed only
when you are in the Edit mode, where the document status indicates “Editing”.

The document status is displayed to the left of these buttons. The document status indicates the following situations:

* In Use — This indicates that another user is currently editing the document.

* View — This indicates that the document is currently in the View mode, and you can only view the pages within the
document.

* Editing — This indicates that the document is currently in the Edit mode, and you can edit the document.

When you edit or delete a document that is shared by other users, make sure to refresh the display to see the latest
status of the document. If the two or more users try to edit or delete the document or the page at the same time, the
data may be damaged.
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Editing With Pages in Your Documents

The e-Filing web utility allows you to copy, move, delete and insert pages and change the order of pages in your
document.

P.89 “Displaying document and page properties”

P.90 “Copying pages from one document to another”

P.95 “Copying pages from a document to a box or folder”

P.99 “Deleting pages from a document”

P.101 “Moving pages within a document”

H Displaying document and page properties

You can display the Document Properties and Page Properties windows that contain details of the document or page. To
display the Document Properties window, select the check box of the document and select [Properties] from the [File]
menu. To display the Page Properties window, select the check box of the page and select [Page Properties] from the
[File] menu.

The Document Properties window contains the following information:

Document Properties

E-l DOC110410-001

Location e-Filing/MUser01/
Total Pageis) 3
Size : 19 MB

Created 2011.0510 09:05:09
Modified : 2011.05.10 09:05:11
LastAccessed 2011.051010:00:59

* Location
Displays the directory where the document is located.
* Total Page(s)
Displays the number of pages the document contains.
* Size
Displays the data size of the document.
* Created
Displays the date and time the document was created.
* Modified
Displays the date and time the document was last modified.
* Last Accessed
Displays the date and time the document was last accessed by any user.
* [OK]
Click this button to close the window.

The Page Properties window contains the following information:

Page Properties

E-l DOC110510-001 (1 73)

Format: Copy
Resolution: 600x% 600
Image Size 4867 16922
Faper Size A4

Size 6710 KB

* Format

Displays how the page is stored.
* Resolution

Displays the resolution of the page.
* Image Size

Displays the pixel size of the page.
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* Paper Size

Displays the paper size of the page.
* Size

Displays the data size of the page.
* [OK]

Click this button to close the window.

H Copying pages from one document to another
You can copy or cut pages from a document and insert them into another one.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the document whose pages
you want to copy or cut.

(¥ Electronic Filing
File

Document B e Filing @ tems)

{8 e-Filing

= [ Public Box
5@ 001 UserDl
Eﬁ 002 Userdz
50 003 UserD3 63
Eﬁ 004 User04
0 005 UserDs
Eﬁ 006 Userlf
&g 007 Userd?

[FlPublic Bax [Flo01 userol

If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber oot

Box Mame User1

BoxPassword: || esssss

* |f you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 In the Document frame, select the document whose pages you want to copy or cut.

QEI tronic Filing Documents | Preferences Login
File Edit

Document & DOCHIOSI0001 {173) Status : View

B e-Filing
[ Public Box
E 4 001 User01 oxz
(] Folderol

[& poc110510

|y DOC110510-001
/i 002 User02
A1 003 UserD3 \
7 004 User04
&gl D05 Userns
%7 D06 User0s
&gl D07 Usern?

User's Manual
Basic Guse

[Flpages 1 [Flpages 2 [Flpages 2

The pages of the document are displayed in the Contents frame.

a

If you want to cut pages from the document, click [Edit] to enter the Edit mode. Clicking [Edit] changes the
document status from the View mode to the Edit mode so that you can cut pages from the document.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is currently
editing the document.

5 Select the check boxes of the pages that you want to copy or cut, and select [Copy] or
[Cut] from the [Edit] menu.
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* When you have cut pages from the document, proceed to the next step after the process is completed.
* When you have copied pages from the document, proceed to step 8 after the process is completed.

Do not perform any operation while the e-Filing web utility is busy.
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6 Click [Save] to save the document.
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2 items are cut.

The Save Document window appears.

7 Enter the document name in the [Document Name] box and click [Save].

Save

y =

I |
DnnumenlNam@CﬂUSWUUm )

* If you rename the document, it will be saved as a new one. If you do not change the document name, the
original document will be overwritten.

The Contents frame displays the pages in the View mode.
* The document status is returned to the View mode from the Edit mode.

Do not close the Save Document window by clicking [X]. The operations may no longer work properly. If you
close the window by clicking [X] by mistake, turn the power to the equipment off and then on again.

In the Document frame, select the box or folder containing the document into which
you want to insert the copied pages.
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The Document is saved,
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber onz2

Box Mame User02

Box Password : ‘ ssssss ’

* |f you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

+ The password input is displayed in the blank symbols. n
Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

In the Document frame, select the document into which you want to insert the copied
pages, and click [Edit].
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The pages of the document are displayed in the Contents frame, and the document status is changed to the Edit
mode from the View mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is currently
editing the document.

11 Click the space between the pages where you want to insert the copied pages.
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The arrow indicators move to the space between the pages where you clicked.
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12 Click the [Edit] menu and select [Paste].
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The copied pages are inserted between the specified pages.

1 3 Click [Save].
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The Save Document window appears.

14 Enter the document name in the [Document Name] box and click [Save].

Save
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* If you rename the document, it will be saved as a new one. If you do not change the name, the original
document will be overwritten.
¢ The document status is returned to the View mode from the Edit mode.

Do not close the Save Document window by clicking [X]. The operations may no longer work properly. If you
close the window by clicking [X] by mistake, turn the power to the equipment off and then on again.
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H Copying pages from a document to a box or folder

You can copy or cut pages from a document and save them in a box or folder as a new document.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the document whose pages
you want to copy or cut.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber: 001

Boy Name : Userd1

Box Password : LLTTLT

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 In the Document frame, select the document whose pages you want to copy or cut.
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The pages of the document are displayed in the Contents frame.

Tip
If you want to cut pages from the document, click [Edit] to enter the Edit mode. Clicking [Edit] changes the
document status from the View mode to the Edit mode so that you can cut pages from the document.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is currently
editing the document.

5 Select the check boxes of the pages that you want to copy or cut, and select [Copy] or
[Cut] from the [Edit] menu.
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* When you have cut pages from the document, proceed to the next step after the process is completed.
* When you have copied pages from the document, proceed to step 8 after the process is completed.

Do not perform any operation while the e-Filing web utility is running busy.
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6 Click [Save] to save the document.

gEﬁ tronic Filing Documents | Preferences Login
File Edit n i

Document E DOCT0510:001 (1/2) Status : Editing
B e-Filing
[l Public Box

E 4 001 User01
(] Folderol
[& Doc110510
DOC110510-001
% 002 User02
&gl D03 Userds
%7 004 User04
&l D05 Userns
7 D06 User0s
&gl D07 Usern?

Fs [Crages 1 [Clrages 2

1item is cut.

The Save Document window appears.

7 Enter the document name in the [Document Name] box and click [Save]. n

Save

y =

. Y
DnnumenlNam@CﬂUSWUUm )

* If you rename the document, it will be saved as a new one. If you do not change the name, the original
document will be overwritten.

¢ The document status is returned to the View mode from the Edit mode

Do not close the Save Document window by clicking [X]. The operations may no longer work properly. If you
close the window by clicking [X] by mistake, turn the power to the equipment off and then on again.

In the Document frame, select the box or folder where you want to store the copied
pages.
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The Document is saved,
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber onz2

Box Mame User02

Box Password : ‘ ssssss ,

* |f you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

10 Click the [Edit] menu and select [Paste].
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Cut
Copy

The document containing the copied pages is created in the selected box or folder.
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H Deleting pages from a document
You can delete pages from a document.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the document whose pages

you want to delete.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

&)

[FlPublic Bax

[Floo1 userol

Password Authentication

Box Mumber:

Boy Name :

Box Password :

ool
Userd1

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be

performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].

4 In the Document frame, select the document whose pages you want to delete, and click

[Edit].
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The pages of the document are displayed in the Contents frame, and the document status is changed to the Edit
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mode from the View mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is currently

editing the document.
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Status : View
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5 Select the check boxes of the pages that you want to delete and select [Delete] from the
[Edit] menu.
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The confirmation dialog box appears.

@ Click [OKI.

Message from webpage (=)

@ Do you want to delete the page(s)?

The selected pages are deleted.

7 Click [Save] to save the document.
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2 items are deleted.

The Save Document window appears.

8 Enter the document name in the [Document Name] box and click [Save].

Save
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* If you rename the document, it will be saved as a new one. If you do not change the name, the original
document will be overwritten.
¢ The document status is returned to the View mode from the Edit mode.

Do not close the Save Document window by clicking [X]. The operations may no longer work properly. If you
close the window by clicking [X] by mistake, turn the power to the equipment off and then on again.
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l Moving pages within a document

You can move pages within a document to rearrange the page order.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the document whose pages

you want to rearrange.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].
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Password Authentication

Box Mumber:

Boy Name :

Box Password :

ool
Userd1

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be

performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].

In the Document frame, select the document whose pages you want to rearrange, and

click [Edit].
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The pages of the document are displayed in the Contents frame, and the document status is changed to the Edit
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mode from the View mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is currently

editing the document.
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Status : View
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5 Select the check boxes of the pages that you want to move between other pages and
select [Cut] from the [Edit] menu.
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The selected pages are copied to the clipboard and deleted from the document.

Do not perform any operation while the e-Filing web utility is running busy.

6 Click the space between the pages where you want to insert the copied pages.
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1item is cut,

The arrow indicators move to the space between the pages where you have clicked.

7 Click the [Edit] menu and select [Paste].
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The copied pages are inserted between the specified pages.

8 Continue the procedure from steps 5 to 7 to rearrange the pages.
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9 After you have completed rearranging the pages, click [Save].
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1iterm is pasted.

The Save Document window appears.

10 Enter the document name in the [Document Name] box and click [Save].

Save
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If you rename the document, it will be saved as a new one. If you do not change the name, the original

document will be overwritten.
The document status is returned to the View mode from the Edit mode.
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Do not close the Save Document window by clicking [X]. The operations may no longer work properly. If you

close the window by clicking [X] by mistake, turn the power to the equipment off and then on again.

Editing With Pages in Your Documents

103



Moving and Merging Documents

You can move documents between boxes or folders. You can also combine several documents into one document.
P.104 “Moving documents”
P.106 “Merging documents”

l Moving documents
You can move a document from one box or folder to another, to help you manage the documents.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the document that you want
to move.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber: 001

Boy Name : Userd1

Box Password : LLTTLT

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 Select the check boxes of the documents that you want to move and select [Cut] from
the [Edit] menu.

¥ Electronic Filing Login
File Edit S

Document o lEE select Al
Invert Selection
B e-Filing
@ Public Box o
El 6 001 Userol \
7] Folderol - "
& DOCL10510 LD

= User's Manual User's Manual
[ DOC110510-001 ot Guise Basi use

&l D02 Usernz
éa 003 User03
gl D04 Usern4
éa 005 User0S
&l D06 Userds

F 007 User0? [FIFalderol
110510 [[pocii0510-
[Scan] ool
1 [Copy]

The selected documents are copied on the clipboard and deleted from the current box or folder.

Do not perform any operation while the e-Filing web utility is running busy.

In the Document frame, select the box or folder where you want to paste the
documents.

(g Efectronic Filing
File Edit View
& Usedl (2 items)

Documents Preferences Login

Document

E 6 001 Userol
] Foldero1

|y DOC110510-001
Al 002 Usernz
5@ 003 User0s G
Al 004 UserDs
&gl D05 Userns
5Fl D06 UserOs
&gl D07 Usern?

User's Manual
Basic Guse

[FIFalderol

[[pociiosio-
oo1
[Copy]

If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Boo Murnber: 00z

Boy Name : Userl2

Box Password : ‘ LLTTLT ’

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.
Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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7 Click the [Edit] menu and select [Paste].

¥ Electronic Filing Login
File Edit :

Document o JOER setect Al

Invert Selection
B e-Filing
[ Public Box E:lw
E 48 001 User01
(2] Folderdl \
[ DOC110510-001 selete
Bl 6 002 Usern2
7 Foldernz
&l D03 Userns
& D04 Users
&l D05 Userns
& D06 User0&
@ 007 Userd? [CIFolderoz

The documents are created in the selected box or folder.

H Merging documents

You can copy an entire document and insert its pages into another document.

The document that you want to insert is the source document, and the document that you want to merge it into is the
destination document.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the source documents.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber: 001

Boy Name : Userd1

Box Password : ‘ LLTTLT ’

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.
Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 Select the check boxes of the source documents and select [Copy] from the [Edit]

menu.
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The selected documents are copied to the clipboard.
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Do not perform any operation while the e-Filing web utility is busy.

5 In the Document frame, select the box or folder containing the destination document.
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If you select a box that is protected with a password, the Password Authentication

[[pocii0sio-
oo1
[Copy]

Documents Preferences Login

window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber: 00z

Boy Name : Userl2

Box Password : ‘ LLTTLT ’

* If you enter an invalid password several times to open the box, you may not log in for a certain period since

it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be

performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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7 In the Document frame, select the destination document, and click [Edit].

@Eﬁ tronic Filing Documents | Preferences Login
File Edit

Document E DOC1105810-002 (1/3) Status : View
B e-Filing \
F@ Public Box z
E 4 001 User01 onr

(] Folderol
[ DOC110510-001 || et
Bl g 002 Usern2
() Foldernz
| DOC110510-002
Al 002 User03
G 004 User0d I
Al 005 User0s
&l D06 Userds
Al 007 User0?

[Flpages 1 [Flpages 2 [Flpages 2

The pages of the document are displayed in the Contents frame, and the document status is changed to the Edit
mode from the View mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is currently
editing the document.

8 Click the space between the pages where you want to merge the documents.

@Eﬁ tronic Filing Documents | Preferences Login
File Edit . i

Document [& DOC110510-002 {143 Status : Editing -Save o
B e-Fiing - - : _ -
@ Public Box
B #6001 usernl users Manual

(] Folderol
[ DoCc110510-001
Bl g6 002 Usern2
] Folderoz
DOC110510-002
% 003 User0a
&gl D04 Usern4
%f D05 User0s
&l D06 Userds
% 007 User0?

R

Fs [Crages 1

The arrow indicators move to the space between the pages where you have clicked.

9 Click the [Edit] menu and select [Paste].

¥ Electronic Filing Login
File Edit . ¥

Document [ DOCT =] Status : Editing

Invert Selection
i e-Filing - -
[ Public Box
E 4 001 User01
(] Folderol k—
[& DOC110510-001 Delete
El £ 002 Usern2
(2] Foldero2
DOC110510-002
Al 002 User03
&l D04 Usern4
Al 005 User0s
&l D06 Userds
Al 007 User0?

Cut
Copy

[Crages 1 [Clrages 2 [Clrages 2 -~

The copied documents are merged between the specified pages.

Tip

If multiple documents have been copied, the documents are merged in order from the oldest one.
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1 0 Click [Save].

@Eﬁ tronic Filing Documents | Preferences Login
File Edit View Layout ] P

Document & DOCTOS10002 (445) Status : Editing =
B e-Filing p—

[l Public Box

E #6001 Usernl e

() Folderol
[ DoC110510-001
Bl £ 002 Usern2
] Folderoz
DOC110510-002
% D03 User0a
&l D04 Usern4
#f D05 User0s
&l D06 Userds
%7 007 User0?

1

DDageE 1 DPages 2 DPages 3 DPages 4

[Clrages s
ol v 4 2

The Save Document window appears.

11 Enter the document name in the [Document Name] box and click [Save].

Save

y =

m
DucumemNam{OCHDSm-DM )

* If you rename the document, it will be saved as a new one. If you do not change the name, the original
document will be overwritten.
* The document status is returned to the View mode from the Edit mode.

Do not close the Save Document window by clicking [X]. The operations may no longer work properly. If you
close the window by clicking [X], turn the power to the equipment off and then on again.
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SYSTEM ADMINISTRATION

This chapter describes system administration of the e-Filing features.

Safeguarding Data..........ccooeeiiiiiiii i —————————— 12
EFASING DOXES ...ttt ettt ettt st e ekt e ettt h et e e R et e eh e et e eR et e et et e nannee e s nee e e naneenaane 112
UNIOCKING USEI DOXES ...ttt ettt et e et e e e et e eh et eea b et e e e e e s e et e e e s e e e ae e e e enreennnas 113



Safeguarding Data

An administrator should periodically monitor e-Filing to make sure it has enough hard disk space for everyday operations.
This section describes the administrator’s function that allows you to delete boxes and the unlocking method of the user
boxes which have been locked by incorrect password entries.

P.112 “Erasing boxes”

P.113 “Unlocking user boxes”

H Erasing boxes

You can manually erase boxes in e-Filing if the data has been corrupted, for example, by a hard disk failure and is
therefore no longer usable.

Log on to the Administrator page.

P.37 “Logging in as a system administrator”
The Box Management page is displayed.

* |tis recommended to archive the documents in the boxes before deleting them. Once the boxes have been
deleted, you cannot restore the documents in the boxes.
P.73 “Archiving documents”
* The Backup/Restore utility included in the software DVD-ROM allows you to back up data in the boxes.
Tip
You can display the Box Properties window by clicking the box number or box name link.

2 Select the check boxes of the user boxes that you want to delete and click [Delete].

Logout

@ Electronic Filing

Box Management
eFiling Disk Space Available : 10142 MB

| Stored Data | Data Type | Data Size [ Remarks
| Box | Shared File | aT B |

| | Unlock

A BoxNumber Box Name Used capacity Status
2 001 Userol 57 WB

002 Usern2 5KB

003 Userns 5KB

004 UserD4 40 MB

005 Users 5KB

006 User0s SKB

007 Usern? 5KB

Top | Help

The confirmation dialog box appears.

For more information about the Box Management Subtab, see the following page:
P.41 “[Box Management] subtab”

3 Click [OK].

Message from webpage

|@ Do you want to delete the item(s)?

W

The selected user boxes are deleted from e-Filing.
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H Unlocking user boxes

When the Lockout Setting of e-Filing is set to “Enable” in the Password Policy, if an incorrect user box password is entered
a specified number of times consecutively, the user box is locked so that it cannot be used for a certain time. The system

administrator can unlock user boxes which have been so locked.

The Password Policy can be set in TopAccess. For details of the password policy, refer to the TopAccess Guide.

Log on to the Administrator page.
P.37 “Logging in as a system administrator”
The Box Management page is displayed.

Tips

* For locked user boxes, “Locked” is displayed in the Status.
* You can display the Box Properties window by clicking the box number or box name link.

2 Select the check box of the user box that you want to unlock, and the click [Unlock].

Logout

P Electronic Filing

Box Management
e-Filing Disk Space Available : 10142 MB

Stored Data | Data Type | Data Size [ Remarks
| B | Shared File | a7 ue |

v A B Humber Box Name Used capacity Status
&) 2n1 Useril 57 MB
,E 002 Userng 5K8
’E 003 Userti3 5KB
004 Userdd 20 WB Lacked
’E il Userds 5KB
B 008 Userns 5KB
=) 007 User07 5KB
1

Top | Help

The lock of the selected user box is released.

For more information about the Box Management Subtab, see the following page:
P.41 “[Box Management] subtab”
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